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CHAPTER 1

Preface
This section provides information about who the intended audience is, the software requirements,
technical support resources, and documentation conventions used. It includes the following
sections.
• About this Guide
• Intended Audience
• Software Requirements
• Technical Support Resources
• Documentation Conventions

About this Guide
This guide describes the key features of the Echo Array Maker Application.

Intended Audience
The intended audience for this guide is laboratory personnel. Researchers can use this guide to
design arrays with custom patterns and create transfer protocols for transfers from microplates to
a variety of substrates with the Echo Liquid handler.

Software Requirements
To use the Echo Array Maker Application, the following items are required:
• Echo Liquid Handler instrument using server version 2.4.x or later and Echo.Net Framework
version 1.8.0
• Software license key from Beckman Coulter.
• Computer system meeting the following requirements:
— Operating system: Microsoft Windows 10 64-bit, (must be run in Windows 7 Compatibility
Mode); Microsoft .Net Framework
NOTE Echo Array Maker Application will run in 32-bit mode on Windows 10 64-bit Operating
System.

— CPU: Intel® Core™ i5 or later
— Memory: 4 GB or greater
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1-1

Preface
Technical Support Resources

— Network connection: 2 x 10/100/1000 BaseT
— Network protocol: TCP/IP
— Hard drive: 4 GB Free Space Available
— Video: Minimum 1600 x 1200 resolution
The Echo Array Maker Application works closely with the Echo Liquid Handler Software for Client
Computers and should be installed on the same client PC.
The Echo Software Compatibility Matrix table below documents the versions of software supported
by this guide and their compatibility.
Table 1.1 Echo Software Version Compatibility Matrix
Echo Client Software

Echo Application Soft- Tempo Automation Conware
trol Software

Echo.Net Framework

2.4.5 - 2.5.x

1.5.4 or later

1.5.2 or later

1.5.4 or later

2.4.5 - 2.6.x

1.6.0 or later

1.6.0 or later

1.6.0 or later

2.4.5 - 2.6.x

1.7.0 or later

2.1.xa or

later

1.7.0 or later

3.1.x

1.7.2 or later

2.1.xa or later

1.7.2 or later

2.4.5-2.6.x

1.8.0 or later

2.2.0 or later

1.8.0 or later

3.1.x

1.8.0 or later

2.2.0 or later

1.8.0 or later

a. Check with your Beckman Coulter Sales Representative for availability.

NOTE For information on the compatibility of a specific software version, please contact us.

Customer Responsibilities
The customer is responsible for installing, configuring, and securing the Windows 10 operating
system on their computer, including the creation of any user accounts and password complexity
rules that may apply, and the application of any software patches and security updates that are
necessary to keep the system secure. The customer is also responsible for installing anti-virus and
anti-malware software and keeping the virus definitions from the vendor up to date so as to keep
the computer safe.
The Echo application software accepts certain inputs, such as Sample ID and Sample Name, which
the user might populate with personally identifiable information. Furthermore, the Echo
application software uses those inputs to generate reports that are stored unencrypted on the disk.
Accordingly, it is the responsibility of the customer to ensure that the information provided to the
Echo application, and subsequent reports that are stored on the disk, do not contain any personally
identifiable information, or that the information is obfuscated or encrypted when stored on the
disk to comply with any applicable regulations related to data privacy and security.

Technical Support Resources
For technical support issues, contact Customer Service www.beckman.com/support/technical.
1-2
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For telephone support, call (877) 742-6548.

Documentation Conventions
Table 1.2 Documentation Conventions
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Style

Purpose

blue italicized text (PDF, Web only)

Cross references, link, Web addresses

courier std

Commands, filenames, directories, paths, user input

bold text

Interactive interface objects, keys, buttons

italicized text

Book titles, glossary terms
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Introduction
Introduction
The Echo Array Maker application provides a variety of plate transfer functions to the Echo Liquid
Handler and works with all Echo Liquid Handlers. With an interactive graphical editor, researchers
can design custom spotting patterns to build custom arrays. In a similar fashion, researchers can
create and edit protocols that map the transfer of fluids from microplates to the custom arrays
using the Echo Liquid Handler. A variety of spotting patterns can be created for microarrays,
MALDI-chips, and more.
The steps to creating a typical transfer protocol for Echo Array Maker Application are shown
below.
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1

Define a new destination plate type or verify that the required plate type exists. For more
information, see Labware Definitions For Array Making.

2

Create an array or arrays within a new destination plate type (slide holder or microplate). For
more information, see Adding a New Destination Array.

3

Create, add, or edit the pattern of spots within the array. For more information, seeAdding a
Pattern to the Pattern Library, Editing a Pattern in the Pattern Library, and Adding Patterns to
a Destination Array.

4

Create a transfer protocol to transfer samples from microplate to arrays on the new destination
plate. For more information, see Creating a Transfer Protocol.

5

Run the protocol. For more information, see Running a Protocol.
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CHAPTER 3

Getting Started
This chapter describes the basic tasks to start, set up, and exit the Echo Plate Reformat application.
It includes the following topics.
• Starting the Software
• Activating the Instrument
• Importing the Labware
• Understanding the Main Window
• Setting Up the Software
• Shutting Down the Software

Starting the Software
To start the Echo Array Maker application:

C68411AA

1

Open the Start menu.

2

Select All Programs (or Programs) > BeckmanCoulter > Echo Array Maker.

3

Select the Echo Array Maker application.
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Figure 3.1 Location of Echo Array Maker application

NOTE To create a shortcut to the Echo Array Maker application on the computer desktop, right-click on
the Echo Array Maker icon and select Send to and Desktop.

After launching the application, the Connect to Instrument prompt is displayed.
Figure 3.2 Connect to instrument dialog box

The Connect to Instrument dialog box connects the Echo Array Maker application to a specific
Echo instrument, if there are multiple instruments. If there are no instruments listed for
Instrument, it means that the application has never connected to an instrument. After the first
time a user connects to the instrument from the application, that Echo instrument will be
added to the dropdown list in the application.
NOTE Activating an instrument allows the user to run an actual protocol on a licensed Echo instrument.

The user can still connect to the Echo instrument and create a protocol even if the licensing
requirements have not been completed, but must click the Work Offline button to work offline. The
protocol can be created but cannot be run until the licensing requirements have been met. If the user
recently installed or upgraded the software, the instrument will need to be activated. See Activating
the Instrument for more information.
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4

Choose one of the following start options:
• Connect: Select an Echo Liquid Handler from the Instrument menu and click Connect. The
Main Window opens with the connection status and instrument information at the bottom
of the screen. This option enables the user to execute the sample or reagent survey as soon
as the transfer protocol is ready.
Figure 3.3 Echo Array Maker application connected to an Echo Liquid Handler

• Work Offline: Click Work Offline. The Echo Array Maker application opens with the
connection status set to offline the bottom of the screen. This option enables the user to
create a transfer protocol and run a simulation without connecting to the Echo Liquid
Handler.

C68411AA
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Figure 3.4 Echo Array Maker application offline

Activating the Instrument
To run a protocol created from the Echo Array Maker application on an Echo Liquid Handler, the
user must activate this application for each Echo Liquid Handler. Each application has to be
activated for the instrument connected.
• The Echo Array Maker application must be activated with the software license key provided by
Beckman Coulter.
• If the Echo Array Maker application was installed with the Echo Liquid Handler by a Beckman
Coulter support engineer, the activation step should not be necessary.
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1

Start the Echo Array Maker application. See Starting the Software for more information.

2

In the Connect to Instrument dialog box, type the name or IP address of the Echo server to
connect to and click Connect.

C68411AA

Getting Started
Activating the Instrument

Figure 3.5 Connect to instrument dialog box

3
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Click the Tools tab in the Toolbar and select the Activate Instrument option.

3-5

3

Getting Started
Importing the Labware

4

Enter the license key. The license key is an encrypted block of text that authorizes the user to
run the Echo Array Maker application with a specific Echo Liquid Handler
The license key can be entered in either of the following ways:
• Copy the license key from the file received from Beckman Coulter and paste it into the
License Key text box.
• Click the Open License Key File button and browse for the license key file.
Figure 3.6 Activate instrument screen

NOTE The Get Current Key function is a useful troubleshooting tool used to verify that the key is written
correctly to the instrument. When the Get Current Key button is clicked, the application searches
for the license key and inserts it into the License Key text box. In case of an error, send the
encrypted key to Beckman Coulter to determine if the license key is corrupted or if it applies to a
different instrument.

5

Click the Activate button.
The Echo Liquid Handler should be activated now. This procedure is not required again unless
a different instrument is activated or the application needs to be upgraded.

Importing the Labware
When connecting to an Echo instrument for the first time, the associated Labware files must be
imported. This is required each time the Echo Array Maker application is connected to a new Echo
instrument or if the Labware for a previously connected Echo changes. If the user skips this step,
they may find that an error occur when loading plate types.
To import Labware:

1

3-6

Select the Tools > Labware Definitions menu option. The Plate Type List dialog box is displayed.
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Figure 3.7 Labware Definitions dialog box

2

Click Import to load the Labware files. The Open Labware File dialog box is shown.

3

Navigate to and select C:\Labcyte\Echo\Protocols\EAMDestinationLabware.elwx.

4

Click Open to load the Labware file. The following Labware Destination plates types are added:
• 4-Slide-Holder
• Greiner_CrystalQuick_96
• Intelliplate_96x3well_LP
• Intelliplate_96x3well_LVR
• SwissCI_96x3well

C68411AA
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Figure 3.8 Labware Definitions dialog box after EAMDestinationLabware.elwx file is imported

5

Click Save to save the imported Labware.

6

Click Close to exit the Plate Type List dialog box.

Understanding the Main Window
When an existing protocol is opened, the main Window displays the Protocol window. If a new
protocol is created, the Protocol Setup window is shown before the main Window. For more
information on the Protocol Setup window, see Starting a New Protocol.
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Figure 3.9 Main Window
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The table below describes the buttons/fields or sections in the Main Window and their functionality.
Table 3.1 Callout table for Main Window

3-10

Callout Name
Number

Description

1

Toolbar

The toolbar contains software menus that provide options to open and save
transfer protocols, set up the software, define Labware, run the protocol,
customize protocol options, and display the online Help. The icons in the toolbar
provide shortcuts to the most frequently selected options, such as the Run
Protocol function. For a detailed description, see Toolbar.

2

Protocol
window

The protocol window is labeled with the protocol file name. The software uses an
.eam file extension and stores the file in the default directory:
C:\Labcyte\Echo\Protocols. The default directory can be changed to a user
specified directory.

3

Protocol
window tabs

The window tabs open the following software windows:

5

Status bar

The status bar displays Echo connection information, such as instrument name,
serial number, and the version of Echo client software that is running.

6

Navigation
and Exit
buttons

The left and right arrows become active when there are too many protocols open
to view all of the file names. The arrows shift the protocol tabs left or right to
display the file names. The Exit icon closes the displayed protocol.

• Main Protocol window — The main Protocol window is the first window that
is displayed when a new or existing protocol is opened. It contains all of the
default protocol data necessary to perform the transfer. For a detailed
description, see Protocol Tab.
• Options window — The Options window displays protocol-specific options,
such as survey history, output file type, and report formats. For a detailed
description, see Options Tab.
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Setting Up the Software
The Echo Array Maker application is simple to set up. Default settings, such as output file type and
report format, can be modified here. The Echo Array Maker application provides transfer data in
three file formats (csv, xml, and txt) with reporting options that can be customized to meet
protocol-specific needs.
To change the default settings, and set up preferences:

1

Open the Tools menu and select Preferences.
Figure 3.10 Preferences/Options dialog box

2

Select Maintain survey history to re-use the current plate survey for more than one transfer
operation for a specified period of time. For more information, see Surveys.

3

Select Run-specific or Plate-specific for the output files.
• Run-specific — Stores all of the transfer results in a file.
• Plate-specific — Stores all of the transfer results in separate files.

4

Select GAL files to generate reports in the custom GAL file type.
• Directory — Change the directory location for the GAL report.
• Filename — Change the file name for the GAL report.

C68411AA
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5

Customize the transfer and survey reports:
• File type — Select XML, CSV, and/or TXT file formats.
• Format — Customize the transfer/survey report header, body, and footer.
• Directory — Change the directory location for the transfer/survey report.
• Filename — Change the file name for the transfer/survey report.
These options are used as default settings for all transfer protocols. To change the options for
an individual protocol, use the Options tab. For more information, see Options Tab.

Shutting Down the Software
There are two ways to exit the Echo Array Maker application:
• Open the File menu and select Exit.
Figure 3.11 Exit function in the File menu

• Click the Close icon in the application.
Figure 3.12 Close window icon

3-12

C68411AA

CHAPTER 4

Software Operations
This chapter describes how to use the Echo Array Maker application. It includes the following
topics.
• Understanding Destination Arrays
• Managing Patterns
• Adding Patterns to a Destination Array
• Starting a New Protocol
• Selecting the Source Plate Type and Destination Array Type
• Understanding Mapping Mode
• Creating a Transfer Protocol
• Running a Protocol
• Advanced Features

Understanding Destination Arrays
A destination array incorporates a Labware definition and custom spotting patterns into a single
object for creating transfer protocols. A Destination Array can be composed of several arrays each
with their own unique spotting pattern.
There are five destination array examples that are available when Echo Array Maker is installed. As
mentioned in the previous section, the supporting Labware for these default Destination Arrays
may need be imported before using these.
The default Destination Arrays and corresponding Labware and patterns are listed below:
Labware

Default Destination Array

Pattern(s)

4-Slide-Holder

4-Slide-12x384-well_Array

384-well pattern

Greiner_CrystalQuick_96

Greiner_CrystalQuick_96-well

3x1 pattern

Intelliplate_96x3well_LP

Intelliplate_96x3well_LP

3x1-well pattern Reservoir

Intelliplate_96x3well_LVR

Intelliplate_96X3well_LVR

3well_pattern

SwissCI_96x3well

SwissCI_96x3well

Reservoir 3-spot_pattern

Additional destination array types can be added by editing the destination array types listed above.
Destination arrays also have patterns defined within them. For more information about patterns
referenced above, see Managing Patterns.

C68411AA
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Labware Definitions For Array Making
Labware for Array Making incorporates several additional attributes in comparison to standard
microplate definitions. The details associated with each parameter and their relationship to one
another are defined here. Creating and using each attribute is described in the upcoming sections,
Creating Patterns for Array Making and Managing Patterns.

Labware
To properly define a destination array, the user must first define the physical substrate the array
will be created on. This is achieved through the creation of a new Labware definition. The Labware,
depending on its configuration, is capable of holding any number of different arrays.
A Labware definition specifies physical characteristics required by the Echo Liquid Handler for
proper positioning. The dimensions include information such as plate height and the offsets that
indicate to the device where the wells are defined. When transferring fluids to the bottom of a
microplate well, the Labware definition corresponds to the physical characteristics of the
microplate. Each individual well can serve as the foundation of a destination array. When
transferring fluids to microarrays in a slide holder, the Labware definition corresponds to the
physical characteristics of the slide holder. Each well of the slide holder represents the location of
a slide and serves as the foundation to create destination arrays. An example of this is provided in
the sections below. For more information about defining Labware, see Labware Definitions.
Labware is a shared resource across all Echo Software Applications. Labware definitions are stored
within the Echo Liquid Handling software. Upon first installing the Echo Array Maker software, the
corresponding Labware definitions for the default arrays and patterns will need to be imported if
not previously done. This should be performed by a Service Engineer upon installation.
The default Labware file for the Echo Array Maker software is located at:
C:/Labcyte/Echo/Protocols/EAMDestinationLabware.elwx

New Labware definitions can be created directly from within the Echo Array Maker software, and
these definitions are stored within the Echo Liquid Handling software. These definitions may
require reloading if the software is upgraded or if the computer is connected to a different device.
This process is different than defining Labware for array making. For more information, see
Importing the Labware.
The Destination Arrays and Patterns are specific to the Echo Array Maker software and are accessed
and stored only in the Echo Array Maker software.

4-Slide-Holder
In a typical slide holder, all microarrays are in a single row. Each microarray resides in a separate
column.
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In the example below, four microarrays would require 4 columns on the slide holder in a single row
(Columns: 4, Rows: 1).
Figure 4.1 Example 4-Slide microarray holder

The Labware definition for the 4-Slide-Holder is created using the Plate Type Editor dialog box. The
parameters and values are shown below. To load the Plate Type Editor, select Labware Definitions
from the Tools menu and click Add. For more information on the Plate Type Editor, see Plate Type
Editor.
Figure 4.2 Labware values for a 4-Slide-Holder

The Echo Destination Array Editor allows the user to define the destination arrays and patterns for
the selected Labware. To load the Echo Destination Array Editor, select Destination Arrays from the
Tools menu. For more information on the Echo Destination Array Editor, see Destination Arrays.
C68411AA
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Figure 4.3 Defining the destination array and patterns for a 4-Slide-Holder

The table below describes the buttons/fields or sections in the Echo Destination Array Editor dialog
box and their functionality.
Table 4.1 Callout table for Echo Destination Array Editor dialog box
Callout Number Name

Description

1

Pattern

Visual representation for the pattern.

2

Destination
Array

Visual representation of the destination array.

3

Rows

Visual representation of the number of rows in the destination array.
In this example, there is one row.

4

Columns

Visual representation of the number of columns in the destination array.
In this example, there are four columns.

NOTE For information on possible error icons when using the Destination Array Editor dialog box, see
Understanding Destination Array Errors.
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Crystallography Plate
In a typical crystallography plate, there are 96 wells that can be used to create 96 arrays. These wells
or arrays are separated into eight rows (Rows: 8) and twelve columns (Columns: 12).
Figure 4.4 Greiner_CrystalQuick_96-well microplate

The Labware for the Greiner_CrystalQuick_96-well array type is defined using the Plate Type Editor
dialog box. The parameters and values are shown below.
Figure 4.5 Labware values for Grenier_CrystalQuick_96

C68411AA
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The Echo Destination Array Editor allows the user to define the destination arrays and patterns for
the selected Labware.
Figure 4.6 Defining the destination array and patterns for a Grenier_CrystalQuick_96-well microplate

The table below describes the buttons/fields or sections in the Echo Destination Array Editor dialog
box and their functionality.
Table 4.2 Callout table for Echo Destination Array Editor dialog box
Callout
Number

Name

Description

1

Pattern

Visual representation for the pattern.

2

Destination
Array

Visual representation of the destination array.

3

Rows

Visual representation of the number of rows in the destination array. In this
example, there is eight rows.

4

Columns

Visual representation of the number of columnsin the destination array.
In this example, there are twelve columns.

NOTE For information on possible error icons when using the Destination Array Editor dialog box, see
Understanding Destination Array Errors.
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Creating Patterns for Array Making
Patterns are the series of spots that can be assigned to one or more arrays within a Destination
array. Each array can contain one or more unique patterns and each Destination array can contain
one or more arrays.
For more information on patterns, see the following topics:
• Adding a Pattern to the Pattern Library
• Editing a Pattern in the Pattern Library
• Copying a Pattern in the Pattern Library
• Deleting a Pattern in the Pattern Library
• Manipulating Patterns
Figure 4.7 Destination Array Editor dialog box

C68411AA
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Viewing the Destination Array Library
To view existing destination arrays:

1

Select the Tools > Destinations Arrays menu option. The Destination Arrays dialog box is
displayed.
Figure 4.8 Destination Arrays dialog box

2

Select an Array Type to view a graphical representation of the array.

Adding a New Destination Array
To add a new destination array:

4-8

1

Select the Tools > Destinations Arrays menu option. The Destination Arrays dialog box is
displayed. See Destination Arrays dialog box.

2

Click the Add new button. The Destination Array Editor dialog box is displayed.
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Figure 4.9 Destination Array Editor dialog box

3

Enter the Name of the array.

4

Select Labware from the drop-down menu. Based on the Labware selected, the Number of
Arrays, Rows of Arrays, and Columns of Arrays fields will be automatically filled in with the
corresponding values.
For example, if the Labware selected is the 4-Slide-Holder, the fields will automatically be filled
in to reflect the Labware definition for Rows and Columns. In this case, that is 1 Row and
4 Columns.
NOTE The red exclamation icon indicates that no Labware has been set. Once the user selects valid

Labware, the red exclamation icon will be removed. For more information on possible error icons,
see Understanding Destination Array Errors.
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Figure 4.10 4-Slide-Holder selected for the Labware

If the Labware selected is the SwissCI_96x3well plate, the fields will automatically be filled in to
reflect that Labware definition. In this case, that is 8 Rows and 12 Columns.
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Figure 4.11 SwissCI_96x3well selected for the Labware

C68411AA

5

Create or select a pattern to add to an array. For more information on how to create or add a
new pattern, see Adding a Pattern to the Pattern Library and Editing a Pattern in the Pattern
Library.

6

Highlight one or more arrays and click Add to add the selected pattern. For more information
on how to add a pattern to an array, see Adding Patterns to a Destination Array.

7

Click Save to save the new array.

4-11

4

Software Operations
Understanding Destination Arrays

Editing a Destination Array
To edit an existing destination array:

1

Select the Tools > Destinations Arrays menu option. The Destination Arrays dialog box is
displayed. See Viewing the Destination Array Library.

2

Select the Array Type and click Edit to modify the destination array properties. The Destination
Array Editor dialog box is displayed. See Destination Array Editor dialog box.

3

To create or add a pattern to add to the destination array, see Adding a Pattern to the Pattern
Library and Editing a Pattern in the Pattern Library.

4

To add the pattern to the destination array, see Adding Patterns to a Destination Array.

5

Complete any other desired changes to the patterns and destination array.

6

Click Save to save the array.

Copying a Destination Array
Copying an existing Destination Array can be used to associate an array with a new type of Labware
without having to recreate the array or the patterns associated with it.
To copy an existing destination array into a new one (duplicate):
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1

Select the Tools > Destinations Arrays menu option. The Destination Arrays dialog box is
displayed. See Destination Arrays dialog box.

2

Select the Array Type and click Copy to copy the destination array. The Destination Array Editor
dialog box is displayed. See Destination Array Editor dialog box.

3

The software automatically appends “- Copy-01” to the name for the copied destination array.
The user can keep this new name or change the Name for the destination array.

4

Complete any other desired changes to the patterns and destination array.

5

Click Save to save the destination array.
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Deleting a Destination Array
To delete an existing destination array:

1

Select the Tools > Destinations Arrays menu option. The Destination Arrays dialog box is
displayed. See Destination Arrays dialog box.

2

Select one or more Array Type and click Delete to delete the destination array. The Confirm
Delete dialog box is displayed.

3

Click Yes in the Confirm Delete dialog box to delete the destination array.
NOTE Click No in the Confirm Delete dialog box to cancel deleting the destination array.

CAUTION
Use the Delete destination array option with caution, as there is no undo.

Open From an Existing Destination Array
The Open From option allows the user to view a destination array, but does not import the
destination array to the list of destination arrays. To import the array that was opened using the
Open From function, the user must save the array.
NOTE A destination array must be imported before it can be used in a protocol. Using the Open From option
does not import the destination array. The user must save the array after opening it in order to use it.

To open an existing destination array:

1

C68411AA

Select the Tools > Destinations Arrays menu option. The Destination Arrays dialog box is
displayed. See Destination Arrays dialog box.
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2

Click Open From to open an existing array. The Import Destination Arrays dialog box is displayed.
Figure 4.12 Import Destination Arrays dialog box

3

Select the destination array (.holder) to be opened and click Open. The Destination Array Editor
dialog box is displayed with the selected destination array. See Destination Array Editor dialog
box.

4

Complete any desired changes to the patterns and destination array.

5

Click Save to save the destination array.

Importing an Array
The Import option allows the user to import one or more arrays to the list of Destination Arrays.
To import an existing destination array:
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1

Select the Tools > Destinations Arrays menu option. The Destination Arrays dialog box is
displayed. See Destination Arrays dialog box.

2

Click Import to import an existing array. The Import Destination Arrays dialog box is displayed.
See Import Destination Arrays dialog box.
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3

Select the destination array (.holder) to be imported and click Open. The selected destination
array is added to the list of array types. To view details for the imported destination array, open
the Destination Array Editor.

NOTE If the user attempts to import a destination array with the same name as an existing destination array,
a warning dialog box is displayed, asking the user if the destination array should be overwritten or not.

Exporting a Destination Array
Use the Export option to export destination arrays developed on one Echo Liquid Handler to
another Echo Liquid Handler.
To export an existing destination array:

1

Select the Tools > Destinations Arrays menu option. The Destination Arrays dialog box is
displayed. See Destination Arrays dialog box.

2

Select the Array Type and click Export to export the array type. The Browse For Folder dialog
box is displayed.
Figure 4.13 Browse For Folder dialog box

3

Select the location to export the array to and click OK.
Click Cancel in the Browse For Folder dialog box to cancel exporting the destination array.

C68411AA
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Exporting a CSV
Exporting a .csv file after creating a Destination Array allows the user to create a .csv file that will
contain the specifications of the pattern(s) transferred to the destination array. This should include
the exact position of individual spots on the array for use with downstream analysis devices.
To export as a CSV file:

1

Select the Tools > Destinations Arrays menu option. The Destination Arrays dialog box is
displayed. See Destination Arrays dialog box.

2

Select the Array Type and click Export CSV to export the array type as a CSV. The Save As dialog
box is displayed.
Figure 4.14 Save As dialog box
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3

Select the location to export the array to and click Save.

4

Click Cancel in the Save As dialog box to cancel exporting the array.
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Understanding Destination Array Errors
Various warning and error icons are used to indicate if there is a problem with the destination
array. Information such as plate type name, plate type definition, labware, and dimensions must all
be correct to successfully use a destination array.
The table below describes the icons displayed for missing or incorrect information, possible error
messages, and some possible solutions the user should try to fix the error(s).
NOTE The possible solutions listed below are only applicable for the Echo Destination Arrays dialog box.

These messages are displayed in the Labware section at the bottom of the dialog box. In addition to the
messages, solution buttons are available that allow the user to fix the errors.
If error icons are displayed in dialog boxes other that the Echo Destination Arrays dialog box, the user
should use the tooltips to get information about the error.

C68411AA

Icon

Destination
Array has
Destination
Plate Type
Name

Destination
Array has
Destination
Plate Type
Definition

Destination
Plate Type
is defined
in the
Labware

Destination Message
Plate Type is displayed
in the
Destination
Array and
the Labware
have the
same
dimensions

Possible solutions

No icon

Yes

Yes

Yes

Yes

None. Labware
name is
displayed.

Not applicable

Yes

No

Yes

Yes

Labware is not
included in the
Destination
Array.

Click Add to
Destination Array
to add this Plate
Type from Labware
to the Destination
Array.

Yes

Yes

Yes

Yes

1. Click Update
Labware and
Labware to copy
Destination
this Plate Type
Array refer to
from the
same Plate Type
Destination
of different
Array to the
dimensions.
Labware
Definitions.
2. Click Update
Destination
Array to copy
this Plate Type
from Labware to
the Destination
Array.
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Icon

Destination
Array has
Destination
Plate Type
Name

Destination
Array has
Destination
Plate Type
Definition

Destination
Plate Type
is defined
in the
Labware

Destination Message
Plate Type is displayed
in the
Destination
Array and
the Labware
have the
same
dimensions

Possible solutions

Yes

No

Yes

No

Labware is not
included in the
Destination
Array, and
Labware and
Destination
Array refer to
same Plate Type
of different
dimensions.

Click Update
Destination Array
to copy this Plate
Type from Labware
to the Destination
Array.

Yes

No

No

Not
Applicable

Labware is not
defined in the
Echo.

None

Yes

Yes

No

Not
Applicable

Labware is not
defined in the
Echo.

Click Add to
Labware to add this
Plate Type from
Destination Array to
the Labware
Definitions.

Managing Patterns
A spotting pattern indicates the geographical location for fluid transfers to a destination array.
A pattern can consist of one or more spots in a custom arrangement. One or more patterns can be
defined on one or more arrays when creating a destination array.
The topics below show different ways to manage patterns:
• Adding a Pattern to the Pattern Library
• Editing a Pattern in the Pattern Library
• Manipulating Spots in a Pattern
• Copying a Pattern in the Pattern Library
• Deleting a Pattern in the Pattern Library
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Adding a Pattern to the Pattern Library
Patterns are created for specific array types. Pattern dimensions are limited by the array
dimensions for which they were created.
To create a pattern:

1

Create or open an array. See Adding a New Destination Array or Editing a Destination Array.

2

In the Destination Array Editor dialog box, click Add New next to the Patterns library. The
Pattern Editor dialog box is displayed.
Figure 4.15 Pattern Editor dialog box
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3

Enter the Name for the pattern.

4

Click Create Spots. The Create Pattern dialog box is displayed.
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Figure 4.16 Create Pattern dialog box

5

Set the Top-left offset to the first spot dimensions: X and Y in microns.

6

Set the Center-to-center distance between spots dimensions: X and Y in microns.

7

Set the Number of Spots implicitly by setting Number of Rows and Number of Columns. The
maximum number of rows and columns are defined by the pattern Center-to-center distance
between spots. As the distance between spots increases, the number of possible rows and
columns will decrease. Alternatively, as the distance between spots decreases, the number of
possible rows and columns increases.

8

Set the Print region dimensions. The Print region is defined as the Width and Height of the area
within which the spots will be contained. The Print region is constrained by the dimensions of
a single array. For example, in a 4-Slide-12x384-well_ Array, if a new pattern was created for use
on the array, the Print region would default to the size of a single array, or slide in this case. In
the example shown above, the Width is 25000 μm and the Height is 75000 μm.
If the default pattern that is defined for use in this array is used, the Print region is constrained
to a size that is smaller than the actual height of a single array. When constrained, the Width
would be 25000 μm and the Height would be 25000 μm. This allows the pattern to be duplicated
to fit three times onto a single array as shown in the figures below.
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Figure 4.17 384-well pattern duplicated onto the 4-slide-12x384-well_Array

C68411AA
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9

Click Create to create the pattern specified by the previous steps. The Create Pattern dialog box
is closed and the user is returned to the Pattern Editor dialog box. See Pattern Editor dialog box.

NOTE Once the pattern is created and saved, the user is returned to the Pattern Editor dialog box. If the

user hovers the mouse over one of the spots, information is shown in the Spot Info fields on the lower
right side of the dialog box. If the user clicks on a spot, the editable fields are activated. Spot Info is
automatically generated and is not editable by the user. Other fields such as Name, Location X and
Location Y can be edited and can be used when the need arises to move an individual spot within a
pattern. For more information, see Manipulating Spots in a Pattern.

Editing a Pattern in the Pattern Library
To edit a pattern:

1

Select and open an existing destination array. See Editing a Destination Array.

2

In the Destination Array Editor dialog box, select a pattern and click Edit in the Patterns section.
The Pattern Editor dialog box is displayed.
Figure 4.18 Pattern editor dialog box
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3

Click on the Create Spots button. The Create Pattern dialog box is displayed. Use this dialog box
to edit and make changes to the desired fields.
Figure 4.19 Create Pattern dialog box

C68411AA
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4

Click Save to save changes to the pattern. Click Cancel to discard any changes made and close
the dialog box.
NOTE If the user clicks the Cancel button in the Pattern Editor dialog box, the changes made in the
Create Pattern dialog box will not be saved to the pattern.

If the Cancel button was clicked after making changes to the pattern in the Create Pattern dialog
box, these changes will not be saved to the pattern.
Figure 4.20 Pattern Editor dialog box

Manipulating Spots in a Pattern
The tasks below can all be completed in the Pattern Editor dialog box. See Pattern Editor dialog box.
NOTE When referring to coordinates for spots, the coordinates are relative to the center of the pattern.

To select a spot
• Click on a spot to select a single spot.
• Hold the Shift or Ctrl key to select multiple spots.
NOTE The user can also drag and select multiple spots however care should be taken when using this
technique as spots can inadvertently be moved when selecting the spots if the beginning of the
selection is not made outside of the spot area.
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• Press the left mouse button and drag a rectangle around the desired spots to select multiple
spots.
• Set the pivotal spot. (Optional)
— The pivotal spot is used to reposition the spot selection precisely by changing location
coordinates.
— The pivotal spot is initially the top-left spot within a group of spots.
— If the user selects multiple spots, one of the spots is highlighted with a lighter color. This is
known as the pivotal spot. The coordinates for this pivotal spot are shown in the Spot Info
section.
— The user can reposition the pivotal spot selection as a whole group by changing the values
for the Location X,Y text boxes. This allows the user to specify a new location for the pivotal
spot, and the rest of the selected spots are moved accordingly by the same position delta.
— User can press Ctrl+click on any spot to make it a pivotal spot.

To change spot locations for single or multiple spots
• Restricted — Selecting Align to Grid will force the placement of any spot to the alignment grid.
• Unrestricted — When Align to Grid is not selected, spots can be positioned freely within the
print region using one of the following methods:
— Using a mouse to click-and-drag a spot to any location.
— Selecting a spot, then using arrow keys to incrementally move the spot to any location.
— Selecting a spot, then changing the X and Y offsets parameters of the Spot Info section.
Figure 4.21 Spot info section

To change the spot name
Edit the spot name text box.

To change the spot color
Click Spot Color and select the new spot color.

To change the background opacity
Change the Background opacity value. Values range from 0 (fully transparent) to 255 (fully opaque).

To reset the spots
Click Reset to auto regenerate all the spots.
C68411AA
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To delete the spots
Select the spots to be deleted and click Delete spots, or click the Delete button on the keyboard.

Copying a Pattern in the Pattern Library
To copy a pattern:

1

Open an array. See Editing a Destination Array.

2

In the Destination Array Editor dialog box, select a pattern and click Copy in the Patterns section.
The Pattern Editor dialog box is displayed. See Pattern Editor dialog box.

3

Change the Name for the pattern.

4

Complete any desired changes to the pattern.

5

Click Save to save the pattern.

NOTE Click Cancel in the Pattern Editor dialog box to cancel saving the changes to the pattern.

Deleting a Pattern in the Pattern Library
To delete a pattern:

1

Open an array. See Editing a Destination Array.

2

In the Destination Array Editor dialog box, select a pattern and click Delete in the Patterns
section.

NOTE The pattern is deleted without a warning if the pattern is not being used. If the pattern is being used,

a warning message is displayed, prompting the user if it is okay to delete the pattern. If the user selects
Yes to delete the pattern, the pattern is deleted from the pattern library and from the arrays.
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Adding Patterns to a Destination Array
To add a pattern to a destination array:

1

Open an array. See Editing a Destination Array.

2

In the Patterns section on the upper right side of the Array Editor dialog box, select the pattern
to be added to the array.

3

In the Select section, select the array in which to add the pattern to.
• To select a single destination array, click on the array to be selected.
• To select more than one destination array, use Ctrl+click to select or deselect multiple
arrays. Dragging the mouse over the desired destination arrays to select multiple arrays
can also be used to select multiple destination arrays.
• To select all of the available destination arrays, click the Arrays All button.
• To deselect all of the selected destination arrays, click the Arrays None button.
Figure 4.22 All of the destination arrays selected in the Destination Array Editor

C68411AA
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4

In the Patterns to Arrays section on the lower middle section of the Array Editor dialog box, click
Add to add the selected pattern from step 2 to the array(s) selected in step 3.
This adds the selected pattern to the first available region on the destination array(s) according
to the Print Region specified in the Pattern. The figure below shows that a pattern was added to
each of the selected destination arrays. In the event that only a single destination array was
selected, the pattern would be only added to that destination array.
Figure 4.23 Adding a pattern to each of the selected destination arrays in the Destination Array Editor
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5

To copy the selected pattern(s) in the array, click Copy.
Figure 4.24 Selecting and copying a pattern to be pasted in the Destination Array Editor

C68411AA
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6

To paste the pattern copied in the previous step, select the desired array(s) and click Paste.
Figure 4.25 Pasting the copied pattern in the Destination Array Editor

NOTE When using the Copy and Paste functions, ensure that duplicate patterns are not inadvertently

added into the same region of the Destination Array. To check this, hold the mouse over one of the
patterns and a list of the current patterns that were placed in that region are shown.
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Figure 4.26 Mouse over pattern showing list of current patterns in that region in the Destination Array
Editor

If duplicate patterns were added, remove the undesired patterns by right clicking on the
pattern. A list of the patterns that were replicated is shown. Left click on the extra pattern to
select only that pattern and click on the Delete button in the Patterns section. These steps may
have to repeated multiple times if multiple patterns were replicated to the same region of
the array.

C68411AA
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Figure 4.27 Left click selecting pattern to be deleted in the Destination Array Editor

7
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To further manipulate the patterns added to the array, see the Manipulating Patterns topic.
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Manipulating Patterns
For lower level adjustments of the pattern placement on an array, use the Selected Pattern, Position,
and Replication sections on the bottom right corner in the Destination Array Editor dialog box.
Figure 4.28 Selected Pattern, Position, and Replication sections of the Array Editor dialog box

NOTE The values for Name, ID, and Array in the Selected Pattern section are automatically filled based on
the pattern selected by the user. These fields cannot be manually changed by the user. When patterns
overlap, a mouse click on a single pattern selects all the patterns under the mouse cursor.

A cursor tool-tip shows all the content under the cursor: spot(s), pattern(s), and the parent array.
Figure 4.29 Cursor tool-tip showing stops, patterns, arrays

C68411AA
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To adjust pattern locations
• To select a single pattern when multiple patterns overlap in an array, right-click on the
patterns. A context menu shows the list of all the patterns under the cursor: name, ID, and
parent array name. Click on the item in the list that should be selected.
• In the Position section, set the values for X and Y and click Apply.
NOTE The Apply button does not become enabled until clicking outside of the Y field.

To undo/redo a pattern location change
In the Position section, click on the blue left arrow to undo and the blue right arrow to redo the
previous position set, respectively.

To replicate patterns in an array
• Select the pattern(s) to be replicated.
Figure 4.30 Pattern selected with Replicate button highlighted in the Destination Array Editor

• In the Replication section, click Up, Down, Left, or Right depending on the desired direction to
replicate the pattern.
• Green preview boxes are displayed to illustrate the number of times the pattern can be
replicated in the selected direction. The Count and the Offset are programmatically changed to
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reflect the maximum number of times the pattern can be replicated. See Selected Pattern,
Position, and Replication sections of the Array Editor dialog box.
• To accept the number of replicates as indicated by the green boxes, click Replicate.
• To decrease or change the number of times the pattern is replicated, change the value for
Count, and then click Replicate
NOTE If the Count value entered exceeds the capacity of the array, the application ignores the value
entered, and uses the maximum value possible.

Figure 4.31 Single replicate pattern being created in the Destination Array Editor

• To change the offset between each pattern being replicated, change the Offset value, and then
click Replicate.
NOTE Programmatically, the application prevents the user from replicating patterns beyond the size of
the array, but the user is allowed to overlap patterns.

C68411AA
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To zoom in/out and navigate the array
Figure 4.32 Main array view and preview screen

• Use the slider below the preview screen above the Selected Pattern section to zoom in and out
of the destination array.
• Click in the preview screen above the Selected Pattern section to navigate a specific location in
the destination array.
• Double-click in the preview screen to zoom in for the patterns being shown in the main array
view.
• Right double-click in the preview screen to zoom in for the patterns being shown in the main
array view.
• The red outline box in the preview screen represents the patterns being shown in the main
array view.
• In the main array view:
— Double-click while pressing the space bar to zoom-in.
— When zoomed-in, press the space bar and press the left mouse key to move the array view.
NOTE When referring to coordinates for patterns, the coordinates are relative to the top-left corner of the
array.

Starting a New Protocol
There are multiple ways to start a new protocol.
1. Select New from the File menu.
2. Click the New

icon in the Toolbar.

3. Press CTRL+N from the keyboard.
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Figure 4.33 Protocol Setup window

• All new protocols start with the Protocol Setup window. This window defines the plate names,
plate types, and array types for source to destination plate transfers.
• Plate type information is used to build appropriate graphics in the protocol creation window.
NOTE For information on possible error icons when using the Protocol Setup window, see Understanding
Destination Array Errors.

Selecting the Source Plate Type and Destination Array Type
The Echo Liquid Handler dynamically adjusts to different changes in fluid characteristics within a
broad fluid class (Dynamic Fluid Analysis). Choosing the plate format determines the physical plate
parameters that the Echo Array Maker application uses. Choosing the plate type determines the
transfer method that the Echo Liquid Handler uses; taking the plate format and fluid properties into
account. These settings enable the Echo system to transfer multiple fluid types from the same
source plate. For example, using the plate format 384PP and plate type MyBuffer_AQ_GP instructs
the Liquid Handler to transfer samples from a 384PP format plate with a transfer method suited for
the Glycerol with Protein fluid class.
These steps are critical when creating the application protocol.

C68411AA

1

In the Protocol Setup window, select the Plate Format to be 384PP, 384LDV, or 1536LDV. Based
on the plate format chosen, the compatible plate types appear for Plate Type.

2

Select the Plate Type to set the transfer properties for the Source Plate.
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3

Select the Array Type to set the transfer properties for the Destination Array.

4

Click OK to create the protocol with the specified source plate and destination array type.

NOTE Not all plate formats and plate types are available on all instruments. The specific plate requirements
per user environment are specified in the purchase agreement and programmed into the instrument
prior to shipping.

Understanding Mapping Mode
There are three different mapping modes available. For information on each of these mapping
modes, see the topics below:
• Map to Destination
• Map to Spot
• Map to Array

Map to Destination
Map to Destination is the default mapping mode. In this mode, source wells are mapped to spots

within a selected array 1:1. If there are not enough spots in the array to accommodate the number
of transfers mapped, the source region will be cropped. This mode does not require the user to
select specific spots within a pattern and is automatically used if one of the other mapping modes
is not used. For an example using Map to Destination, see Using Map to Destination.

Map to Spot
The Map to Spot view allows the user to map transfers to specific spots or a group of spots within
a pattern. For example, spotting siRNA samples to a microarray.
The functionality of Map to Spot is intended for use with transfers onto a set of slides containing
a series of patterns. Map to Spot uses a series of source wells – designated as a source region and
transfers these onto a series of spots within a pattern on the destination array. Map to Spot does not
support choosing multiple patterns. To choose multiple patterns, use the default mapping mode,
Map to Destination.
When using Map to Spot, the user must select an existing pattern and assign it as the destination
region. For an example using Map to Spot, see Using Map to Spot - Mapping Source Wells to Patterns
on Chips or Microarrays.
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Map to Array
The Map to Array view allows the user to map transfers to specific spots within the same pattern
repeated across multiple arrays within a destination array. For example, transferring the reagent
to the upper left shelf of every array (well) in a crystallography plate.
The functionality of Map to Array is intended for use with transfers onto a microplate, such as a
crystallography plate, where a series of patterns have been defined to represent the various wells
to which different fluids might be transferred. Map to Array uses a series of source wells, designated
as a source region, and will transfer these onto the same spot in a pattern repeated across multiple
arrays on the destination array.
When using Map to Array, the destination arrays are treated as a destination plate and the user must
select an existing pattern and a spot that gets assigned to the destination region. For an example
using Map to Array, see Using Map to Array - Mapping Source Wells to Patterns in Microplate Wells
(Crystallography).

Creating a Transfer Protocol
For the examples below, it is assumed that the required destination arrays have been created.
• Add Region - Map to Destination
• Replicate Region - Map to Destination
• Add Region - Map to Spot
• Replicate Region - Map to Spot
• Add Region - Map to Array
• Replicate Region - Map to Array

Using Map to Destination
The topics below explain the different ways to map to destination:
• Add Region - Map to Destination
• Replicate Region - Map to Destination

Add Region - Map to Destination
NOTE It is assumed that the required destination arrays have been created.
To add transfers from a source region to patterns:

C68411AA

1

Start a new protocol as explained in topic Starting a New Protocol.

2

Select the source plate types and the destination array types as explained in Selecting the
Source Plate Type and Destination Array Type.
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3

In the main Protocol window, select the desired wells as the region in the source plate map from
which the transfers will occur. This becomes the Source Region. The information box for that
region is automatically populated.
In the lower left corner of the main Protocol window in the Region Information section, the user
can select the Add Region and Replicate Region buttons. These allow the user to determine the
way in which the source region is mapped onto the selected destination.
NOTE If the user selects the Treat as identical well content checkbox, the Replicate Region button is
removed. The Treat as identical well content option is only available with the Add Region
command.

Figure 4.34 Main Protocol window highlighting Add Region and Replicate Region buttons

4
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In the main Protocol window, select the destination pattern or patterns to which the source
region will be transferred. To select multiple patterns, use Ctrl + click or click and drag.
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The figures below show screen shots where no patterns are selected and where all patterns are
selected.
Figure 4.35 All patterns selected

Figure 4.36 No patterns selected

5
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Click the Add Region button to duplicate the selected source region into the selected
destination region in a one to one manner.
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Figure 4.37 Adding a region using Map to Destination
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6

Select another source pattern and destination pattern, check Treat as identical well pattern,
and click Add Region.
Figure 4.38 Selecting Treat as identical well and Add Region

Replicate Region - Map to Destination
NOTE It is assumed that the required destination arrays have been created.
To replication transfers from a source plate region to patterns:

C68411AA

1

Start a new protocol as explained in topic Starting a New Protocol.

2

Select the source plate types and the destination array types as explained in topic Selecting the
Source Plate Type and Destination Array Type.

3

In the main Protocol window, select the desired wells as the region in the source plate map from
which the transfers will occur. This becomes the Source Region. The information box for that
region is automatically populated.
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In the lower left corner of the main Protocol window in the Region Information section, the user
can select the Add Region and Replicate Region buttons. These allow the user to determine the
way in which the source region is mapped onto the selected destination.
NOTE If the user selects the Treat as identical well content checkbox, the Replicate Region button is
removed. The Treat as identical well content option is only available with the Add Region
command.

Figure 4.39 Main Protocol window highlighting Add Region and Replicate Region buttons

4
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In the main Protocol window, select the destination pattern or patterns to which the source
region will be transferred. To select multiple patterns, use Ctrl + click or click and drag.
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The figures below show screen shots where no patterns are selected and where all patterns are
selected.
Figure 4.40 All patterns selected

Figure 4.41 No patterns selected

5

Click the Replicate Region button to translate the selected source region and replicate that into
the selected destination region as many times as allowed by the destination pattern selected.
If the destination region is too small to fit a single replicate of the source region, an error
occurs. In the event that the destination region is not an exact multiple of the source region, it
will only replicate a complete set of the source region wells.
NOTE In the example below, the pattern contains two replicate patterns of the source region.
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Figure 4.42 Replicating a region using Map to Destination

Using Map to Spot - Mapping Source Wells to Patterns on Chips or Microarrays
The topics below explain the different ways to map to spot:
• Add Region - Map to Spot
• Replicate Region - Map to Spot

Add Region - Map to Spot
In this example, a 4-Slide-12x384-well_Array is used for the destination array and a 384PP is used for
the source plate format. Map to Spot is used to map transfers from the source plate to the
destination array.
NOTE It is assumed that the required destination arrays have been created.
To add a region to patterns:
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1

Start a new protocol as explained in topic Starting a New Protocol.

2

Select the source plate types and the destination array types as explained in topic Selecting the
Source Plate Type and Destination Array Type.
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3

In the main Protocol window, select the desired wells as the region in the source plate map from
which the transfers will occur. This becomes the Source Region. The information box for that
region is automatically populated.

4

In the main Protocol window, select the destination pattern to which the source region will be
transferred. To select multiple patterns, use Ctrl + click or click and drag.
NOTE Map to Spot is designed to have a one to one relationship with the patterns in a destination array.
Therefore, if multiple patterns are selected, only the first pattern will be mapped for transfer.

Figure 4.43 Source region with single destination pattern selected

C68411AA

4-47

4

Software Operations
Creating a Transfer Protocol

5

Click Map to Spot. This launches the pattern view of the pattern selected in a Pattern dialog box.
Figure 4.44 Pattern dialog box

6
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Select the top-left, or starting spot for the source region to be transferred. The region will be
created according to the dimensions of the source region, if possible or until the edges of the
pattern are reached.
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7

Click the Add Region button or select the Add Region
icon in the Toolbar to add the region
to the selected destination pattern region. The Add Region command translates the selected
source region in a one to one manner.
Figure 4.45 Adding a region to patterns

Replicate Region - Map to Spot
In this example, a 4-Slide-12x384-well_Array is used for the destination array and a 384PP is used for
the source plate format. Map to Spot is used to map transfers from the source plate to the
destination array.
NOTE It is assumed that the required destination arrays have been created.
To replicate a region in patterns:

C68411AA

1

Start a new protocol as explained in topic Starting a New Protocol.

2

Select the source plate types and the destination array types as explained in topic Selecting the
Source Plate Type and Destination Array Type.
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3

In the main Protocol window, select the desired wells as the region in the source plate map from
which the transfers will occur. This becomes the Source Region. The information box for that
region is automatically populated.

4

In the main Protocol window, select the destination pattern to which the source region will be
transferred. To select multiple patterns, use Ctrl + click or click and drag.
NOTE Map to Spot is designed to have a one to one relationship with the patterns in a destination array.
Therefore, if multiple patterns are selected, only the first pattern will be mapped for transfer.

Figure 4.46 Source region with single destination pattern selected
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5

Click Map to Spot. This launches the pattern view of the pattern selected in a Pattern dialog box.
Figure 4.47 Pattern dialog box

6
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Select the top-left, or starting spot for the source region to be transferred. The region will be
created according to the dimensions of the source region, if possible or until the edges of the
pattern are reached.
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7

Click the Replicate Region button or select the Replicate Region
icon in the Toolbar to add
the region to the selected destination pattern region. The Replicate Region command translates
the selected source region and replicates that into the selected destination region as many
times as allowed by the destination pattern selected.
Source region with single destination pattern selected shows the four source wells selected in
the source region replicated across the destination region that correspond to exact multiples
of the source region.
Figure 4.48 Replicating a region

NOTE If the destination region is too small to fit a single replicate of the source region, an error message
is generated. In the event that the destination region is not an exact multiple of the source region, it
will replicate as many complete sets of the source region wells as possible.

8
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Select any optional steps as needed.
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The following section provides detailed information on the optional steps that can occur mapping
transfers to an array.

Optional steps after adding or replicating a region
To change the volume:
• In the Region Information box, enter the required volume value. The default value is 2.5 nL.
To set a source interleave pattern:
• To quickly transfer contents from or to wells in an interleaved pattern, select the Source
Interleave option. This allows a user to set the row-wise or column-wise spacing for interleaved
transfers.
The default value for the Source Interleave option is 1, 1, or no interleave. For more information
on interleave, see Using Interleaving.
To set a Pre-Transfer Delay:
• To use advanced features such as Pre-Transfer Delay, see Using Pre-Transfer Delay.
To change the color for the source region:
• Click Color and choose a different color.
To treat all the wells identical (only applicable for replicate):
• To use advanced features such as Treat as Identical Well Content, see Transferring Identical
Well Content.

Using Map to Array - Mapping Source Wells to Patterns in Microplate Wells
(Crystallography)
The topics below explain the different ways to map to array:
• Add Region - Map to Array
• Replicate Region - Map to Array

Add Region - Map to Array
In this example, a SwissCI_96x3well array is used for the destination array and a 384PP is used for
the source plate format. Map to Array is used to map the source plate to the destination plate.
NOTE It is assumed that the required destination arrays have been created.
To add a region:

1
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Start a new protocol as explained in topic Starting a New Protocol.
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2

Select the source plate types and the destination array types as explained in topic Selecting the
Source Plate Type and Destination Array Type.

3

In the main Protocol window, select the desired wells as the region in the source plate map from
which the transfers will occur. This becomes the Source Region. The information box for that
region is automatically populated.

4

For the Map to Array command, selection of the destination array(s) to which the source region
will be transferred occurs after the user clicks on Map to Spot. Designating the destination
arrays in the main Protocol window is not required.
Destination Arrays are represented by the wells of a crystallography plate.
Figure 4.49 Before map to array is executed

5
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Click Map to Array. This launches the array view of the Destination Array in the main Protocol
window.
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6

Select the destination arrays (wells) containing the spots to which the source region will be
transferred to. If more than one pattern exists in the destination array(s), select the desired
pattern using the Pattern drop-down menu.
The destination array below contains 2 patterns: 3-spot_pattern and Reservoir. For this
example, the Reservoir pattern is selected which maps the contents of each well of the source
region into the corresponding reservoir wells on the crystallography plate.
Figure 4.50 Selecting the Reservoir pattern

C68411AA

4-55

4

Software Operations
Creating a Transfer Protocol

7

Using the Spot drop-down menu, select the specific spot to be used for all of the destination
arrays selected.
Figure 4.51 Selecting the spot

NOTE Map to Array is designed to function in a one to one relationship with selected spots in the

destination arrays. If the 3-spot_pattern were chosen, the user would specify to which of the 3 spots
the source region wells should be transferred.

NOTE The blue right and left arrows can be used to select the previous or next spot in the pattern.
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8

Click the Add Region button or select the Add Region
icon in the Toolbar to add the region
to the selected destination pattern region. The Add Region command translates the selected
source region in a one to one manner.
Figure 4.52 Add region executed

9

Select any optional steps as needed. For more information on the optional steps available, see
Optional steps after adding or replicating a region.

Replicate Region - Map to Array
In this example, a SwissCI_96x3well array is used for the destination array and a 384PP is used for
the source plate format. Map to Array is used to map the source plate to the destination plate.
NOTE It is assumed that the required destination arrays have been created.
To replicate a region:

1
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Start a new protocol as explained in topic Starting a New Protocol.
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2

Select the source plate types and the destination array types as explained in topic Selecting the
Source Plate Type and Destination Array Type.

3

In the main Protocol window, select the desired wells as the region in the source plate map from
which the transfers will occur. This becomes the Source Region. The information box for that
region is automatically populated.

4

For the Map to Array command, selection of the destination array(s) to which the source region
will be transferred occurs after the user clicks on Map to Spot. Designating the destination
arrays in the main Protocol window is not required.
NOTE Destination Arrays are represented by the wells of a crystallography plate.
Figure 4.53 Before map to array is executed

5
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Click Map to Array. This launches the array view of the Destination Array in the main Protocol
window.
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6

Select the destination arrays (wells) containing the spots to which the source region will be
transferred to. If more than one pattern exists in the destination array(s), select the desired
pattern using the Pattern drop-down menu.
The destination array below contains 2 patterns: 3-spot_pattern and Reservoir. For this
example, the Reservoir pattern is selected which maps the contents of each well of the source
region into the corresponding reservoir wells on the crystallography plate.
Figure 4.54 Selecting the Reservoir pattern
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7

Using the Spot drop-down menu, select the specific spot to be used for all of the destination
arrays selected.
Figure 4.55 Selecting the spot

NOTE Map to Array is designed to function in a one to one relationship with selected spots in the

destination arrays. If the 3-spot_pattern were chosen, the user would specify to which of the 3 spots
the source region wells should be transferred.

NOTE The blue right and left arrows can be used to select the previous or next spot in the pattern.
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8

Click the Replicate Region button or select the Replicate Region
in the Toolbar to add the
source region to the selected destination spot across the selected destination arrays. Replicate
region translates the selected source region and replicates that into the selected destination
spots across the destination array as many times as allowed by the number of destination arrays
selected.
NOTE If the number of destination arrays is too small to fit a single replicate of the source region, an

error message is generated. In the event that the destination arrays is not an exact multiple of the
source region, it will replicate as many complete sets of the source region wells as possible.

Figure 4.56 Add region executed

9

C68411AA

Select any optional steps as needed. For more information on the optional steps available, see
Optional steps after adding or replicating a region.
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Running a Protocol
To begin a protocol simulation or live run:
Figure 4.57 Run Options Dialog Box
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1

Select Run from the Protocol menu or click the Run

2

Select the Instrument if it is not already selected.

3

Optionally, enter a Reference ID and/or Order ID to be used to reference the run in the output
report files.

4

For the Full Plates option defined by the protocol, specify the number of source plates to
process. The number of source plates are defined in the protocol and cannot be overridden in
the Run Options dialog box.

5

Click Partial Plates to pick specific plates. When the Partial Plates option is selected, an Import
button is displayed to import a .csv pick list indicating the wells to be transferred. For more
information on how to define a pick list, see Importing a Pick List.

icon in the Toolbar.
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6

In the Destination Plate section, change the value for Plate copies to override the number of
plate copies for the protocol.

7

Click the Plate Calculator button to view the number of plates needed to run the protocol.
Figure 4.58 Plates Used dialog box

8

Optionally, click Simulate to test the run.
NOTE Running a simulation is recommended to verify the transfers defined in the protocol before a live
run.

9

Click Run to execute the protocol

Advanced Features
There are many advanced features that a user can use when creating protocols. The topics below
describe what these features are and how to use them.
• Using Pre-Transfer Delay
• Using Repeat Region
• Adding a Fixed Plate
• Using Interleaving
• Transferring Identical Well Content
• Importing a Pick List

C68411AA
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Using Pre-Transfer Delay
The Pre-Transfer Delay sets the time delay before starting the transfer for a given region. It is used
in cases where there may be a requirement to pause shortly between transfers.
The Pre-Transfer Delay should be set before adding a region.
Figure 4.59 Pre-Transfer Delay in Main Protocol Window

Using Repeat Region
The Repeat Region sets the number of times the selected region is repeatedly transferred. it is
recommended to use this option with Pre-Transfer Delay.

Adding a Fixed Plate
To add controls to the plates, use the fixed plate option:
Figure 4.60 Fixed Plate Selected in Main Protocol Window

1
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Start a new protocol as explained in topic Starting a New Protocol.
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2

Select the source plate types and the destination array types as explained in topic Selecting the
Source Plate Type and Destination Array Type.

3

Select Fixed in the Protocol Plates tree in the main Protocol window.

4

Select the Before Source Plate or After Source Plate option.

5

Click the Add Plate button or click the Add Plate

icon in the Toolbar.

Figure 4.61 Fixed Plate Setup Dialog Box

6

In the Fixed Plate Setup dialog box, select the Format and the Default Type and click OK.

7

Select the new Fixed Plate in the Protocol Plates tree in the main Protocol window.

8

In the main Protocol window, select the desired wells as the region in the source plate map. The
information box for that region automatically opens.

9

Click on a pattern or use the mouse to select the pattern directly. To select multiple patterns,
use Ctrl+click. See Source region with single destination pattern selected.

10 Enter the Fixed Plate settings in the Region Information box.
NOTE The fixed plate determines the uniform fill volume for the entire plate. The volume ranges are
limited by the plate type.

11
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Select any optional steps as needed. For more information on the optional steps available, see
Optional steps after adding or replicating a region.
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Using Interleaving
Interleaving is only applicable for source plates in Echo Array Maker. To map transfers from
interleaved wells of a source plate to a destination array, the user must select interleave to highlight
the source wells in an interleaved fashion, and then use the map to spot or map to array similar to
what would be performed for a non-interleaved transfer.
To interleave wells in source plate:

1

Add or replicate a region as explained in topic Add Region - Map to Spot or Replicate Region Map to Spot.

2

To quickly transfer contents from or to wells in an interleaved pattern, select the Source
Interleave option. This allows a user to set the row-wise or column-wise spacing for interleaved
transfers.
The default value for the Source Interleave option is 1, 1, or no interleave.
In the example below, the Source Interleave was set for Row 2 and Col 3.This instructs the
application to transfer from neighboring source wells separated by 3 columns to destination
spots that are direct neighbors in X direction. The transfer from neighboring source wells
should be separated by 2 rows to destination spots that are direct neighbors in Y direction.
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3

Select any optional steps as needed. For more information on the optional steps available, see
Optional steps after adding or replicating a region.
Figure 4.62 Interleave wells in source plate to wells in destination plates

NOTE The Interleave option is not available until a region is created. It is available if an existing region
is selected and if the region is not an Identical well content region.

Transferring Identical Well Content
Selecting Treat as identical well content indicates that the contents of wells in a selected source plate
are identical. These wells can be used interchangeably to fill wells of a destination plate. Wells
containing the largest volume in the group will be depleted until all wells have an equal volume.
Once all wells are equal, contents will be transferred in a round-robin fashion. This option is
commonly used for repeated transfers from a group of wells across multiple protocol runs. This
option is available when adding a region.
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To treat wells within a region as having “identical well content”:
For example, to transfer an identical reagent from a group of wells in a source plate to one or more
assay plates.

1

Add a region as explained in topic Add Region - Map to Spot and check Treat as identical well
content before clicking the Add Region button. This action overwrites the pattern by treating
all the source wells identically.
NOTE If an identical well type region is created, the Interleave option is not available.

2

Select any optional steps as needed. For more information on the optional steps available, see
Optional steps after adding or replicating a region.
Figure 4.63 Treat as identical wells selected for region 4
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Importing a Pick List
Importing a pick list from the Run Options dialog box is a quick way to run existing Echo Array
Maker protocols with partial source plates as defined by an input file. Using a pick list eliminates
the need to create a unique protocol.
When importing a pick list via the Run Options dialog box, the pick list parameters override any
plate parameters in the protocol for the run, with the exception of fixed plates. This is typically used
for creating exact copies of a pick list plate.
NOTE The pick list cannot be saved in the protocol.
The pick list is a table of specific wells that have been selected from a group of wells for analysis.
The pick list is typically created in a text or spreadsheet file.
Guidelines for defining pick list:
• Pick lists using row and column location must use the one-based coordinate system, which
means that the first well in the upper left corner of the microplate is labeled row 1, column 1,
or (1,1).
• Pick lists must be saved in .csv file format to be used by the Echo Array Maker application.
The pick list must provide a minimum set of information in columns that map to functional
parameters in the Echo Array Maker application. The minimum set required depends on which
parameters are used. The table below shows four examples of minimum column selections required
for a pick list to be processed.
Columns Selected

CSV Example File

Source Well, Transfer Volume, Destination Array ID,
Destination Pattern ID, Destination Spot ID

EAM Pick List - Greiner_CrystalQuick_
96-well.csv

Source Row, Source Col, Transfer Volume, Destination Array
ID, Destination Pattern ID, Destination Spot ID

EAM Pick List - 4-Slide-12x384-well_
Array.csv

Source Well, Transfer Volume, Array Name, Destination
Pattern ID, Destination Spot ID

EAM Pick List - Intelliplate_96x3well_
LP.csv

Source Row, Source Col, Transfer Volume, Array Name,
Destination Pattern ID, Destination Spot ID

EAM Pick List - SwissCI_96x3well.csv

In addition to the columns listed above, Source Plate Name and Destination Plate Name columns can
be selected to specify unique plates for each transfer. If these values are not mapped to the pick list,
the application assumes the same source and destination plates are used for every transfer in the
pick list.
Using existing files to create a pick list:
• Transfer Reports — Transfer Reports from completed protocol runs are saved as .CSV, .XML, or
.TXT files depending on what the user selected for Save transfer reports as file type in the
Options tab. These files can be imported as pick lists for new protocols. Transfer Reports contain
columns that can be mapped to all source and destination parameters in an Echo application.
For more information, see Transfer and Survey Reports.
• Exported Destination Array — Complete Destination Arrays can be exported to .CSV files via the
Export CSV button in the Destination Arrays dialog box. See Destination Arrays dialog box.
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Columns containing Source Well and Transfer Volume information must be manually added to
the exported .CSV file. Once the information is added, the new file can be imported as a pick list
in an Echo application.
NOTE If an error is encountered when importing a pick list, the error message will show the column data that
is needed.

To import a pick list:

1

To open the Import Pick List dialog box, select Run from the Protocol menu or click the Run icon
in the Toolbar. See Run Options Dialog Box.

2

Click Partial Plates to pick specific plates. When the Partial Plates option is selected, an Import
button is displayed to import a .csv pick list indicating the wells to be transferred.

3

Click Import to import the pick list.

Figure 4.64 Import Pick List dialog box
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The table below describes the buttons/fields or sections in the Import Pick List dialog box and their
functionality.
Table 4.3 Callout table for Import Pick List dialog box
Callout
Number

Name

Description

1

Skip Lines

The pick list can contain heading information (for example, assay
information, date, etc.), but it should be skipped when importing. Select a
numerical value for Skip Lines to skip the number of specified heading
lines for the column headings (header line).

2

Auto-Map button Maps the column headings and data automatically.

3

File contains
header columns

If the pick list contains a header line (column headings), select this option.

4

Delimiter

The delimiter used to separate data in the pick list file.

5

Column Details

• Position — Specifies the position in the file.
• File Header — Specifies the header for the column.
• Column — Specifies the column name. This drop-down list defines the
columns that can be added to the pick list.
• Import — Specifies if the data for the associated column should be
imported or not.

6

Preview Result or The results for this table are toggled based on if the user clicks the
File Content
Preview or the File content button.
table

7

Remove
Check this to remove duplicate entries in the source file when creating the
duplicate line
pick list.
entries checkbox

8

Preview or File
content button

Toggles between the preview result showing the IDs, corresponding
source wells, and other data available and the file content result showing
the line number and corresponding data.

9

Save Column
Mapping to File
button

Exports the column mappings to a text file.

10

Load Column
Mapping from
File button

Imports the column mappings to be viewed.

11

Import button

Imports the source wells, destination wells, and transfer volume into the
current protocol.

NOTE By clicking Import, the existing protocol data is overwritten and
cannot be undone unless the protocol was previously saved.

12
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Cancel button

Closes the Import Pick List dialog box without saving any changes.
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CHAPTER 5

Software Reference
This chapter describes all of the Echo Plate Audit application screens. It includes the following
topics.
• Toolbar
• Protocol Tab
• Options Tab
• Preferences
• Labware Definitions
• Destination Arrays
• Run Protocol
• Simulator Window
• Run Status Window

Toolbar
The Toolbar contains the File, Protocol, Tools, and Help menus, and individual icons for frequently
used functions.
Figure 5.1 Toolbar

The topics below describe the functions that can be performed using the Toolbar.
• File Menu
• Protocol Menu
• Tools Menu
• Help Menu
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File Menu
Figure 5.2 File menu

• Connect to instrument — Selects an Echo instrument to connect to the software.
• New — Creates a new transfer protocol.
• Open — Opens an existing transfer protocol.
• Save — Saves the current transfer protocol.
• Save As — Copies the current transfer protocol to a different file name.
• Exit — Closes the Echo Array Maker software.

Protocol Menu
Figure 5.3 Protocol menu

• Error Check — Checks the protocol for inconsistent information.
• Run — Executes the transfer protocol that is displayed.
• Add Region — Adds the selected region.
• Replicate Region — Replicates the selected region within the highlighted destination region as
many times as possible.
• Delete Region — Deletes the selected region.
• Delete All Regions for Plate — Deletes all the regions for the selected plate.
5-2
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• Delete All Regions — Deletes all the selected regions.
• Add Plate — Adds a new plate to the protocol.
• Delete Plate — Deletes a plate from the protocol.

Tools Menu
Figure 5.4 Tools menu

• Preferences — Used to set survey, output, and report options for all protocols.
• Labware Definitions — Manages existing Labware definitions or adds new definitions.
• Destination Arrays — Manages existing arrays and patterns or creates new arrays and patterns.
• Activate Instrument — Used to enter the software license key to use the Echo Array Maker
software.

Help Menu
Figure 5.5 Help menu

• User Guide — Launches the application User Guide in PDF format.
• Quick Start Guide — Launches the application Quick Start Guide in PDF format.
• About… — Display the version number of the Echo Array Maker software.
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Protocol Tab
The Protocol tab displays the following information:
Figure 5.6 Protocol tab
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The table below describes the buttons/fields or sections in the Protocol tab and their functionality.
Table 5.1 Callout table for Protocol tab
Callout
Number

Name

Description

1

Name

Defines the name of the protocol.

2

Description

Sets a brief description for the protocol.

3

Protocol

Selecting the protocol in protocol tree is used to set
protocol specific features.

4

Source Plate Type

Defines the source plate type used in the protocol.

5

Source Plate(s)

Defines the source plate(s) used in the protocol.

6

Region(s)

Defines the region(s) in a source plate.

7

Destination Plate Type

Defines the destination plate type and plate format for
the protocol.

8

Destination Plate

Defines the destination plate name(s) receiving
transfers for the protocol.

9

Fixed Plate

Defines a fixed plate for the protocol.

10

Selected source plate, source plate
type, source region information,
and destination array type

The fields displayed in this Region Information section
change based on the type of protocols being used.

11

Dest Array

Read-only field that indicates the location for the
destination array.

12

Pre-Transfer Delay

Defines the time delay before the starting the transfer
for this region. This can be used in cases where there is
a requirement to incubate shortly between transfers.

13

Volume

Defines the volume transferred from the selected
region.

14

Source Interleave

The row or column that is selected from the source
plate is interleaved before it is transferred.

15

Region Order

These arrows are used to change the order (up and
down) of the regions in a plate. This is important if the
regions have Pre-Transfer Delay set.

The Protocol tab has many fields that change depending on what is selected. Furthermore,
depending on what is selected in the Protocol Plates tree, the bottom left information box can
change. The examples below illustrate the different fields that appear depending on what is
selected in the Protocol Plates tree.
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In the Protocol Plates tree of the Plate Design tab, if Protocol is selected, the following settings
become available:
Figure 5.7 Protocol selected

The table below describes the buttons/fields in the Protocol Information section and their
functionality.
Table 5.2 Callout table for Protocol Information section
Callout Number

Name

Description

1

Number of plate copies

Number of times the plate should be copied.

2

Process plates in this
protocol

Defines the order in which to process the plates.

Optimize transfer
throughput

Echo overrides the order of operation specified in the
protocol and reorder transfers to minimize stage and
transducer movements.

3

5-6

• Automatic — Protocol defines the optimum
sequence.
• Source plate-centric — Minimizes source plate
swapping.
• Destination plate-centric — Minimizes
destination plate swapping.
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In the Protocol Plates tree of the Plate Design tab, if Source or Destination plate type is selected, the
following settings become available:
Figure 5.8 Source plate type selected

The table below describes the buttons/fields in the Protocol Information section and their
functionality.
Table 5.3 Callout table for Protocol Information section
Callout Number

Name

Description

1

Name

Name of the source plate.

2

Plate Type

Defines the plate type.

NOTE Changes are applied once cursor is removed from the field modified.
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In the Protocol Plates tree of the Plate Design tab, if a specific Source or Destination plate is selected,
the following settings become available:
Figure 5.9 Source plate selected

In the Regions for Plate box, the regions for the selected plate are listed. The user can click Edit to
modify a region or Delete to remove a region from the plate.
The following fields can be modified for a region:
• Pre-Transfer Delay
• Repeat Region
• Volume
• Source Interleave or Treat as Identical (Treat as identical is only available if the region is not an
identical well type region)
• Color
NOTE If there are no regions for the plate, this list will be empty.
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In the Protocol Plates tree of the Plate Design tab, if a specific Region is selected, the following
settings become available:
Figure 5.10 Region selected

The table below describes the buttons/fields in the Region Information section and their
functionality.
Table 5.4 Callout table for Region Information section

C68411AA

Callout
Number

Name

Description

1

Source Plate Type

Defines a combination of a physical plate and a fluid type for a plate.

2

Pre-Transfer Delay

Pre-Transfer Delay sets the time delay before starting the transfer for
a given region.

3

Repeat Region

Repeat Region sets the number of times the selected region is
repeatedly transferred.

4

Volume

The volume in nL in the region.

5

Source Interleave or
Treat as Identical

Treat as identical is only available if the region is not an identical well
type region. Select Treat as identical well content to indicate that the
contents of wells in a selected source plate are identical.

6

Color

Color that identifies the region on the plate map.
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In the Protocol Plates tree of the Plate Design tab, if Fixed Plate is selected, the following settings
become available:
Figure 5.11 Fixed plate selected

The table below describes the buttons/fields in the Fixed Plate Run Option section and their
functionality.
Table 5.5 Callout table for Region Information section
Callout Number

Name

Description

1

Process Fixed Plates

Defines the order in which to process the fixed plate.
• Before Source Plates — Process the fixed plate before
the source plates.
• After Source Plates — Process the fixed plate after the
source plates.

2

5-10

Add Plate button

The user can click Add Plate to add the fixed plate. For more
information on adding a fixed plate, see Adding a Fixed Plate
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Add Plate
The Add Plate command allows a user to add a new plate to the protocol.
Figure 5.12 Main Protocol Window Before Add Plate Executed

To add a new plate, in the main Protocol window, select Source or Destination and click the Add
Source Plate

C68411AA

or select the Protocol > Add Plate menu option.
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Figure 5.13 Main Protocol Window After Add Plate executed
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Delete Plate
The Delete Plate command allows a user to delete a plate from the protocol.
Figure 5.14 Main Protocol Window Before Delete Plate Executed

To delete a plate, in the main Protocol window, select the Source or Destination plate to be deleted
and click the Delete Source Plate

C68411AA

icon or select the Protocol > Delete Plate menu option.
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Figure 5.15 Main Protocol Window After Delete Plate Executed

Select Region
A region must be selected before it can be added or replicated. There are different ways to select
wells:
• Click top-left corner to select all the wells in the plate.
• Click on a number (1-24) to select all the wells in that column.
• Click on a letter (A-P) to select all the wells in that row.
• Click and drag to select specific wells.
NOTE Wells must be selected on the source plates.
There are different ways to select regions depending on the type of destination plates being used.
• Microarray
— A single pattern or multiple patterns can be selected. For more information, see Add Region
- Map to Spot.
• Crystallography
— A single well or multiple wells can be selected on a single pattern and a single spot can be
selected using the Map To Array option. For more information, see Add Region - Map to
Array.
5-14
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Add Region
The Add Region command allows the user to add a region to a source or destination plate.
Figure 5.16 Main Protocol Window Before Add Region Executed

To add a region to a plate, in the main Protocol window, select the Source or Destination plate to add
the region to, and click the Add region
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icon or select the Protocol > Add Region menu option.

5-15

5

Software Reference
Protocol Tab

Figure 5.17 Main Protocol Window After Add Region Executed

NOTE When adding a region, the Treat as identical well option becomes available. For more information,
see Transferring Identical Well Content.
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Replicate Region
The Replicate Region command allows the user to replicate a selected region.
Figure 5.18 Main Protocol Window Before Replicate Region Executed

To replicate a region, in the main Protocol window, select the region in the Source and Destination
plate to be replicated and click the Replicate Region
Region menu option.
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icon or select the Protocol > Replicate
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Figure 5.19 Main Protocol Window After Replicate Region Executed

NOTE For a replicate region the source region must be smaller than the destination region, otherwise the
user receives an error message.
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Delete Region
The Delete Region command allows the user to delete a selected region.
Figure 5.20 Main Protocol Window Before Delete Region Executed

To delete a region, in the main Protocol window, select the region in the Source or Destination plate
to be deleted and click the Delete Region
option.
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icon or select the Protocol > Delete Region menu
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Figure 5.21 Main Protocol Window After Delete Region Executed
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Delete All Regions for Plate
The Delete All Regions for Plate command allows the user to delete all the regions for the selected
plate.
Figure 5.22 Main Protocol Window Before Delete All Regions for Plate Executed

To delete all the regions in a plate, in the main Protocol window, select the Source or Destination
plate whose regions should be deleted and select the Protocol > Delete All Regions for Plate menu
option, or right-click on a plate and select Delete All Regions for Plate.

C68411AA
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Figure 5.23 Main Protocol Window After Delete All Regions for Plate Executed
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Delete All Regions
The Delete All Regions command allows the user to delete all the regions for all the plates with one
command.
Figure 5.24 Before Delete All Regions executed

To delete all the regions for all the plates, in the main Protocol window, select the Protocol > Delete
All Regions menu option or right-click on a main source, or fixed tree item and click on Delete All
Regions to delete all the regions in all the source or all the fixed plates, respectively.

C68411AA
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Figure 5.25 Main Protocol Window After Delete All Regions Executed

Error Check
The Error Check command allows the user to check the protocol for inconsistent information.
To check the current protocol for errors, in the main Protocol window, select the Error Check menu
option.

Run
The Run command initiates the transfer protocol that is displayed.
To run the current transfer protocol, in the main Protocol window, click the Run
select the Protocol > Run menu option. For more information, see Run Protocol.
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Options Tab
The Options tab is accessible by clicking the Options tab behind the Protocol tab. This window
enables the user to customize the survey, output, and reporting options for the Echo Array Maker
application. These settings are automatically used for the protocol created.
Each of the sections in the Options Tab is explained in the following topics.
• Understanding Protocol Options
• Understanding Output Options

Understanding Protocol Options
The Options tab displays the following protocol and output options.
Figure 5.26 Options tab

NOTE The options settings are similar to the Preferences/Options window, but apply only to the protocol
displayed.
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Surveys
There are two ways to manage survey history:
• Re-Survey every source plate — Default setting that automatically surveys the source plate
every time the protocol is run. Survey history is saved, but not referenced each time.
• Maintain survey history — Used to store survey data for source plates.
With Maintain survey history chosen, information from the initial survey is referenced for
subsequent transfers — eliminating the requirement to resurvey.
This feature can reduce processing time during a protocol run — particularly if the source plate
is swapped several times during a protocol run. The user can specify the length of time that the
survey data is retained, from a few minutes to never resurvey.
The software stores the survey data by plate barcode; therefore, the data is independent of the
protocol and can be used across different protocols until the expiration time.
NOTE Various factors can affect the content of the source wells, such as DMSO concentration, humidity,
and exposure time during the transfer run; therefore, consider these factors when selecting an
expiration time. For additional information, read the user note “How Long Will A Survey Last When
Performing Acoustic Droplet Ejections?” on contact us.

The Maintain survey history function is located in the Options tab. If the user selects Maintain survey
history, an Expiration button appears.
Figure 5.27 Surveys box

Click Expiration to open the Survey Data Expiration dialog box and set the expiration values.
Figure 5.28 Survey Data Expiration dialog box
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The following parameters can be set in the Survey Data Expiration dialog box:
• Never expires — Existing survey data is always re-used.
• User-specified expiration time — Existing survey data is re-used for the time that is specified in
minutes or Days:Hours:Minutes.
NOTE If a stored survey does not cover the plate area that is required by the protocol (for example, some of
the wells were empty when the plate was originally surveyed, but then filled later on), the software will
survey the new wells and add this data to the stored survey data.

The stored survey data is instrument-specific. For example, if a source plate is surveyed in instrument A,
the stored survey data cannot be used in instrument B.
Although survey history can be used indefinitely, it is not recommended.

Understanding Output Options
The output options are explained in the following topics:
• Output Files
• GAL Files
• Transfer and Survey Reports

Output Files
The Output Files box in the Options window organizes the survey and transfer results according to
the following criteria:
Figure 5.29 Output Files options

The following parameters can be set for output files:
• Run-specific — All protocol data is stored in one file, in the order that the results are generated.
• Plate-specific — Protocol data is stored in separate files, based on source or destination plates,
depending on the process order specified in the main Protocol window.
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GAL Files
Reports can be generated in the custom GAL file type. The results are saved in the GAL format, and
stored in the directory specified in the Directory option with the Filename specified. A GAL file is
created for each array. For example, if arrays A1, A2, and C5 are used, the generated GAL files will
be named:
• Filename_A1.GAL
• Filename_A2.GAL
• Filename_C5.GAL
NOTE The Filename specified by the user is appended with _arrayname.GAL to create the final filename
for each GAL file.

Transfer and Survey Reports
File Type
Survey and transfer results can be saved to the following file formats that are compatible with most
laboratory information systems:
• XML (extensible markup language)
• CSV (comma separated values)
• TXT (text file)
The results are saved in the formats selected, and stored in the directory specified in the Directory
option with the Filename specified.
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Report Format
The survey and transfer reports can be customized by clicking the Format button in the Protocol
Options tab.
NOTE. The DEFAULT settings in the Transfer and Survey Reports are from the Preferences/Options
window.

Figure 5.30 Report Format Options
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The Output Format Builder dialog box shows all the report variables (left selection box) that can be
added to the report format (right selection boxes). The list of variables changes with the report area
selected.
Figure 5.31 Transfer Output Format Builder

5-30

C68411AA

Software Reference
Options Tab

Figure 5.32 Survey Output Format Builder

NOTE The Include Exception Report option parses out any transfers that were not initiated because of a
failed survey and promotes them to the top of the output file.

Report Directory
The default report directory for both surveys and transfers is C:\Labcyte\Echo\Reports. The
default report directory for GAL files is C:\Labcyte\Echo\Reports\GAL. A different directory can
be specified by clicking the Directory button and entering a new location. Use the Select Folder
button to browse to a different directory.
Figure 5.33 Folder Name dialog box
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Report Filename
The Echo Array Maker application uses the following default formats to report the survey, transfer,
and GAL results:
Survey results file name —
$AppName$\$RunDate$\$InstrSN$_$RunType$_$SrcPlateName$($SrcPlateBarcode$)

For example:
Echo Software\2018-02-22\E5XX-0001_Transfer_Plate1(1-989992-0)
Transfer results file name —
$AppName$\$RunDate$\$InstrSN$_$RunType$_$SessionID$

For example:
Echo Software\2018-02-22\E5XX-0001_Transfer_123
GAL results file name —
$AppName$\$RunDate$\$InstrSN$_$DestPlateName$($DestPlateBarcode$)

For example:
Echo Software\2018-02-22\E5XX-0001_Plate 2(5-989998-3)

The survey and transfer formats can be changed by clicking the Format button in the Protocol
Options tab.
Figure 5.34 Transfer Filename Builder
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Figure 5.35 Survey Filename Builder

Figure 5.36 GAL Filename Builder
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Preferences
The Preferences/Options window is accessible from the Tools menu. This window is very similar to
the Protocol Options tab, but with the following differences:
• Settings are automatically applied to all protocols created unless changes were made in the
Protocol Options window (report formats shown as “default”).
• Accessible from the Toolbar.
When the user clicks Preferences, the Options window opens to display the following protocol
and output options:
Figure 5.37 Preferences/Options Window
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Labware Definitions
The Echo Array Maker application relies on the Labware definitions resident in the Echo Liquid
Handler database. New plate definitions can be added or existing plate definitions can be managed
by selecting Labware Definitions from the Tools menu.
Each of the Labware topics are explained in the following topics.
• Plate Type List
• Plate Type Editor
• Plate Export

Plate Type List
The Plate Type List dialog box enables the user to add new plate definitions or manage existing ones.
Figure 5.38 Plate Type List dialog box

NOTE In case of an error message followed by a blank Plate Type List, connect to an Echo Liquid Handler or
import the Labware file from the Echo Liquid Handler directory.
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The table below describes the buttons/fields or sections in the Plate Type List dialog box and their
functionality.
Table 5.6 Callout table for Plate Type List
Callout Number

Name

Description

1

Cache
Plate
List
Locally

Click this button to save the plate list from the Echo Liquid Handler
to the Echo® Array Maker Application.

2

Add

Adds a plate definition. Only a destination plate can be added. Refer
to one of the following options:
• Add a Labware definition from the Echo® Array Maker
Application.
• Add a plate definition from the Echo Liquid Handler software
and reload the updated Labware definition to the Echo® Array
Maker Application.

3

Edit

Edit a plate definition. Select a plate definition and click the Edit
button.
• Source plate definition: Only the barcode location of the source
plate can be edited.
• Destination plate definition: Edit any setting in the definition.

4

Copy

Copy a plate definition. Select a plate definition and click the Copy
button. The user can copy a source or destination plate definition.
For a source plate definition, an alias or child plate is created with
exact parameters as the parent plate except the user-defined fluid
name. For a destination plate, a destination plate definition is
created. Alternate source or destination plate names can be
created by copying existing plate types.

5

Delete

Delete a plate definition. Select a plate definition and click the
Delete button. The user can delete a destination plate definition or
an alias or child plate definition previously created for a source plate
but not a source plate definition.

6

Import

Import a single plate definition or group of definitions from a specific
file location. The file must have an .elwx extension to be imported.

7

Export

Export a single plate definition or group of definitions. This includes
any user created alias or child plate definitions for source plates and
destination plate definitions that were created.

8

Reload

Reload the plate types that have been edited or deleted since the
plate type list was last saved.

9

Save

Save any changes made to the plate type list, such as adding a new
plate definition.

10

Close

Close the Plate Type List dialog box.

NOTE In case of an error message followed by a blank Plate Type List, connect to an Echo Liquid Handler or
import the Labware file from the Echo Liquid Handler directory.
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Plate Type Editor
The Plate Type Editor dialog box is similar to the Plate Specification window in the Echo Liquid
Handler software.
Figure 5.39 Plate Type Editor dialog box

Source plate definitions — Source plate definitions require exact specifications to accurately
transfer nanoliter volumes; therefore, they are defined specifically for the Echo Liquid Handlers
and tested at Beckman Coulter (Echo-qualified). For this reason, source plates cannot be defined by
the user. For existing source plates, only the barcode location can be edited. Contact Beckman
Coulter to add more source plates.
Destination plate definitions — The Echo Liquid Handler is programmed with several compatible
destination plates; however, the user can add destination plates through the Echo® Array Maker
Application or the Echo Liquid Handler software.
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The table below describes the buttons/fields or sections in the Plate Type Editor dialog box and their
functionality.
Table 5.7 Callout table for Plate Type Editor
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Callout Number Name

Description

1

Name

User-defined name to identify the plate. This name will be listed in the
Plate Type List dialog box.

2

Barcode
Location

Location of barcode label on the destination plate:

3

Manufacturer

Name of the plate manufacturer.

4

Lot Number

Lot number assigned by the plate manufacturer.

5

Part Number

Part number assigned by the plate manufacturer.

6

Rows

Number of rows in the microplate.

7

Columns

Number of columns in the microplate.

8

A1 X Offset

(A)* Distance from left outside edge to center of first column where the
left edge of the part will be defined as the two 12.7 mm areas
(as measured from the corners) as specified in ANSI SLAS 1-2004
(R2012). Valid range: 0.0 to 128.0 mm.

9

A1 Y Offset

(B) Distance from top outside edge to center of first row where the top
edge of the part will be defined as the two 12.7 mm areas
(as measured from the corners) as specified in ANSI SLAS 1-2004
(R2012). Valid range: 0.0 to 86.0 mm.

10

X Center
Spacing (C)

Column spacing: Each following row/column shall be an additional
X.Y mm in distance from the top/left outside edge of the plate as
specified in ANSI SLAS 4-2004 (R2012). Valid range: 0.05 to 9.0 mm.

•
•
•
•

None
Left
Right
Long
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Table 5.7 Callout table for Plate Type Editor (Continued)
Callout Number Name

Description

11

Y Center
Spacing (D)

Row spacing: Each following row/column shall be an additional X.Y mm
in distance from the top/left outside edge of the plate as specified in
ANSI SLAS 4-2004 (R2012). Valid range: 0.05 to 9.0 mm.

12

Plate Height
(E)

The overall height of the plate as specified in ANSI SLAS 2-2004
(R2012). Valid range: 6.5 to 14.5 mm.

13

Flange Height
(F)**

The height of the flange (skirt) as specified in ANSI SLAS 3-2004
(R2012). Valid choices: 2.41 mm, 6.10 mm, and 7.62 mm.

14

Well Width (G) The width of the well opening at the bottom (not an SLAS specified
dimension. Valid range: 0.0 to 86.0 mm.

15

Well Length
(G)

The length of the well opening (not an SLAS specified dimension. Valid
range: 0.0 to 128.0 mm.

16

Well Capacity
(H)

The overall capacity of the well in microliters. Valid range: greater than
0.0 uL.

NOTE * The items marked A-G are measurements that need to be taken by hand or filled in from the

manufacturer's specifications. These dimensions and further details on their definitions can be found at
https://www.slas.org/resources/information/industry-standards/.
** Currently, the Echo Liquid Handler does not use dimensions F (flange height) and H (well capacity).
Any value entered for flange height or well capacity is ignored.
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Plate Export
The Export Plates dialog box displays the plates currently available in the Echo® Array Maker
Application. The user can select and export one or more plates to a file (.elwx file extension) for use
in another application.
Figure 5.40 Export Plates dialog box
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Destination Arrays
The Destination Arrays dialog box enables the user to add new arrays or manage existing ones.
Figure 5.41 Destination Arrays dialog box

The table below describes the buttons/fields or sections in the Destination Arrays dialog box and
their functionality.
Table 5.8 Callout table for Destination Arrays dialog box
Callout
Number

Name

Description

1

Add new

Add a new destination array to a collection of all the destination arrays
available to the application.

2

Edit

Edit an existing destination array.
Select a destination array and click the Edit button.
The user can add new, modify, or remove patterns or change patterns in the
array.

3

Copy

Copy or duplicate an existing destination array.
Select a destination array and click the Copy button.
The user can:
• Change Labware
• Add new, modify, or remove patterns
• Change patterns in the arrays
The destination array copy should be named such that it does not match any
of the existing destination arrays in the collection.
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Table 5.8 Callout table for Destination Arrays dialog box (Continued)
Callout
Number

Name

Description

4

Delete

Delete one or many of the destination arrays from the collection. Select a
destination array and click the Delete button.

NOTE There is no undo for this operation.
5

Import

Import a single destination array type definition or group of destination array
type definitions from a specific file location on a local or network drive. The file
must have an .holder extension to be imported.
This option imports the chosen destination array(s) directly to the local
collection of destination arrays available to the application. If any of new names
match the name of an existing destination array, the user will be warned that
the existing destination array will be overwritten.

NOTE There is no undo if a destination array is overwritten.
6

Export

Export a single destination array type definition or group of destination array
type definitions from the current collection to a location on a local or network
drive. The exported file will be a .holder extension.

NOTE If the file being exported has the same name as a file that already exists
at the chosen location, the user will be warned that the existing file will be
overwritten.

7

Open from

Open an existing destination array file from a location on a local or network
drive in the Echo Destination Array editor dialog box. The file must have an
.holder extension to be imported.
The user can edit this destination array, change name and save it in the local
collection. If the new name matches the name of an existing destination array,
the user will be warned that the existing destination array will be overwritten.

NOTE There is no undo if a destination array is overwritten.
8

Export csv

Export a single destination array from the current collection to a Commaseparated Value (.CSV) file format.

NOTE If a .CSV file with the destination array name already exists at the

specified location, the user will be warned that the existing file will be
overwritten.

9

Close

Close the Destination Arrays dialog box.

For information on possible error icons when using the Destination Arrays dialog box, see
Understanding Destination Array Errors.

Run Protocol
The Run Options dialog box enables the user to run a simulation of the transfer protocol or run the
transfer protocol on the Echo instrument. If the application is not connected to an Echo instrument,
this window also provides a connection dialog box.
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Figure 5.42 Run Options dialog box

To run a protocol:

C68411AA

1

Select Run from the Protocol menu or click the Run

2

Select the Instrument if it is not already selected.

3

Optionally, enter a Reference ID and/or Order ID to be used to reference the run in the output
report files.

4

For the Full Plates option defined by the protocol, specify the number of source plates to
process. Click the Plate Definitions button to view the plates to be used.

5

Click Partial Plates to pick specific plates. When the Partial Plates option is selected, an Import
button is displayed to import a .csv pick list indicating the wells to be transferred. For more
information on how to define a pick list, see Importing a Pick List.

6

In the Destination Plate section, change the value for Plate copies to override the number of
plate copies for the protocol.

icon in the Toolbar.
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7

Click the Plate Calculator button to view the number of plates needed to run the protocol.
Figure 5.43 Plates Used dialog box

8

Optionally, click Simulate to test the transfer protocol.
NOTE Running a simulation is recommended to verify the transfers defined in the protocol before a
live run.

9
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Click Run to execute the protocol.
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Simulator Window
The simulator is an animation of fluid transfer for the selected protocol. The simulation is
interactive and allows the user to respond to a prompt box to insert and remove plates. Since this
is a simulation, the prompt box appears for only 5 seconds, then the software automatically
responds to the prompt and continues to the next step.
The protocol example that is described in this help page uses a pick list of compounds in five source
plates and a control plate transferring to a single destination plate. The components of the
simulator window are described below.
Figure 5.44 Simulator Window
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The table below describes the buttons/fields or sections in the Simulator Window and their
functionality.
Table 5.9 Callout table for Simulator Window
Callout Number

Name

Description

1

Transfer
Animation Box

Simulates the movement of the destination plate (green) as it
receives liquid from the source plate. Each source-to destination
well transfer is documented below the plates.

2

Delays

The following Delays commands are available to manage the
transfer animation.
• Animation (milliseconds) — Controls the speed of the
simulated well-by-well transfer. Speed ranges from 500 ms
to 0; default is 15 ms. Higher speeds are useful to slow down
the animation when transfers jump around the plate. For
example, during backfills.
• Plate Prompt (seconds) — Controls the time interval that the
plate prompt box is displayed, from 30 s to 0. Zero setting is
useful to bypass the prompt box entirely and view the
animation only.
• Skip Animation — Bypasses the animation step and shows
only the transfer results for that step. This control enables the
user to quickly review the plate mapping after each transfer
step.

NOTE This control does not bypass plate prompts or bulk fill
displays.

• Play — Begins the simulated fluid transfer.
• Close — Closes the simulation window. If a simulation is in
progress, it will need to be canceled before the window can
be closed.
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3

Source Plate
Type Map Box

Shows the source plate that is selected for transfer. As the
simulation runs, each source well shows the number of times a
transfer is made from that well.

4

Destination Plate
Type Map Box

Shows each well that receives transfers and the number of
transfers that are received.

5

Protocol
Information Box

Provides details about the transfer protocol, such as the number of
plates that will be needed. As the simulation proceeds, this box is
updated to show which plates are currently in use.
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Run Status Window
The Run Status window is a dynamic window that provides control buttons to run the protocol, and
various status windows to show the progress of the compound transfer, the state of the Echo
instrument, and the final well positions and volume of the transferred fluid.
Figure 5.45 Run status window (Echo 55X Series Liquid Handler)
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Figure 5.46 Run status window (Echo 650 Series Liquid Handler)

The table below describes the buttons/fields or sections in the Run Status window and their
functionality.
Table 5.10 Callout table for Run Status window
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Callout Number

Name

Description

1

Source and
Destination
Plate windows

Shows the status of each plate as it progresses through the transfer
protocol. The Legend interprets the symbols used in the status
windows.

2

Legend

Identifies each of the states (Complete, InProcess, Saved, Pending,
Error) possible for a source and destination plate during a run.

3

Transfer Map
window

Shows the details of each well-to-well transfer.

4

System Status
window

Shows the status of the Echo instrument during the transfer run. If a
problem occurs, an alert is indicated by the colors turning from
green to yellow to red. If it is red, the user needs to do something to
fix it.

5

Transfer Status
window

Shows a progress bar of the transfer protocol, as well as percent
completion and elapsed time. This section also provides a text
window that displays all the actions that occur during the run.
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Table 5.10 Callout table for Run Status window (Continued)
Callout Number

Name

Description

6

Open Door
button

Opens the process door of the connected Echo Liquid Handler.

7

Source Plate
button

Extends the source plate gripper.

8

Destination Plate Extend the destination plate gripper.
Out button

9

Stop button

Stops the transfer protocol that is in progress.

10

Pause button

Pauses the transfer protocol that is in progress.

11

Continue button

Continues the transfer protocol that is in progress.

12

Start button

Begins the transfer protocol.

13

Close button

Closes the Run Status window.

14

Details button

Shows the debugging information for the protocol run.

15

Calibrate button

Starts the focus calibration procedure.

16

Replace button

Starts the coupling fluid replacement procedure (only applies to the
Echo 650 Series Liquid Handler).

Plate Prompt
The Plate Prompt boxes instruct the user to insert or remove a plate. Depending on the protocol,
there may be multiple source and destination plate prompts displayed and the order in which they
are shown is also dependent on the protocol.
The plate prompt steps are described below:

1

Insert the source plate into the source plate gripper stage and click OK.
Figure 5.47 Insert source plate prompt box

NOTE For Echo 650 Series Liquid Handler instruments, the Plate Insert will always be Universal Insert.
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Identify the source plate in one of the following ways:
• Plate ID — Select the Source Plate ID from the drop-down menu.
• Barcode — Select the Barcode field and ensure the Verify Barcode option is selected. The
Echo instrument automatically scans the barcode label on the plate and inserts it into the
Barcode field.
NOTE If the Barcode field was skipped and Verify Barcode was not selected, the software displays
a plate read error.

After the source plate is processed, the software removes it from the drop-down menu.

2

Insert destination plate and click OK.
Figure 5.48 Insert destination plate prompt box

• Select the Source Plate Barcode (or plate ID) from the drop-down menu. If there is only one
destination plate, the software automatically selects it and disables the Verify Barcode
option.
• Select Verify Barcode (optional) and click OK.
After the destination plate is processed, the software removes it from the drop-down menu.
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3

Remove the source plate and click OK.
Figure 5.49 Remove source plate prompt box

4

Remove the destination plate and click OK.
Figure 5.50 Remove destination plate prompt box
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Focus Calibration
The Focus Calibration dialog box is automatically displayed when the user selects Run in the Run
Options dialog box if the Echo Liquid Handler requires acoustic transducer calibration. This is also
indicated by the yellow warning status indicator for Focus Calibration in the System Status section.
Figure 5.51 Focus Calibration Dialog Box

The Focus calibration procedure measures the focal length of the acoustic transducer and compares
it to the previous measurement. If the difference between these measurements is minimal, then the
system updates its calibration database with the new focal length and the procedure is finished. If
the difference is larger than a preset threshold, users should call Beckman Coulter Service and
Support to ensure the system is running properly before accepting the focal length new value.
It is recommended to select Yes and follow the focus calibration steps. If you choose to delay the
focus calibration, you can click the Calibrate button next to the Focus Calibration status indicator in
the System Status section in the Run Status window to start the focus calibration steps.
To run the Focus Calibration procedure:

1

5-52

Click Yes to begin the Focus Calibration procedure. The Focus Calibration dialog box is displayed.
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2

In the Focus Calibration dialog box, click Run.
Figure 5.52 Focus Calibration Dialog Box
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3

The new focus calibration values are displayed. If there are no errors, click Update ToF to update
the focus calibration values. If the focus calibration values are outside the normal range, a red
warning box is displayed indicating the focus calibration values are out of range. If the user
clicks Update ToF, a confirmation dialog box is displayed to ensure the user is aware of
committing calibration values that are out of range. Out of range focus calibration values
should not be committed unless instructed by Beckman Coulter Service and Support.
Figure 5.53 Focus Calibration Dialog Box
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4

Once the focus calibration values have been committed, the Update ToF button is disabled. Click
Close to exit the Focus Calibration dialog box.
Figure 5.54 Focus Calibration Dialog Box
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Coupling Fluid Replacement
NOTE The coupling fluid replacement procedure is only required for the Echo 650 Series Liquid Handler.
The Coupling Fluid Replacement dialog box is automatically displayed when the user selects Run in
the Run Options dialog box a if the Echo Liquid Handler needs coupling fluid replacement. This is
also indicated by the yellow warning status indicator for Coupling Fluid Age in the System Status
section.
Figure 5.55 Coupling Fluid Replacement dialog box

It is recommended to select Yes and follow the coupling fluid replacement steps. If you choose to
delay coupling fluid replacement, you can click the Replace button next to the Coupling Fluid Age
status indicator in the System Status section in the Run Status window to start the fluid
replacement steps.
To start the fluid replacement process:

1

Click Start to begin the coupling fluid replacement process.
Figure 5.56 Coupling Fluid Replacement Start dialog box
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2

The Fluid Replacement Workflow is displayed and step 1 in the workflow is enabled. Go to the
back of the Echo Liquid Handler and remove the coupling fluid bottle. Unscrew the bottle cap
with the attached tubing and then dispose of the used coupling fluid.
Figure 5.57 Coupling Fluid Replacement Workflow displayed

3

After the coupling fluid bottle has been removed, step 2 in the workflow is enabled.
Figure 5.58 Coupling Fluid Replacement Step 1
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4

Fill a clean coupling fluid bottle with 1 Liter Ultrapure Type 1 water and screw on the bottle cap
with the attached tubing. Then replace the coupling fluid bottle in the bottle holder.
Figure 5.59 Coupling Fluid Replacement Step 2

Once the fluid replacement process is started, if the user clicks the Cancel button and the
coupling fluid level is sufficient, the following message box is displayed.
Figure 5.60 Canceling Fluid Replacement dialog box

Once the fluid replacement process is started, if the user clicks the Cancel button and the sensor
indicates that either the coupling fluid bottle is empty or not present, the following messages
are displayed.
Figure 5.61 Canceling Fluid Replacement dialog box
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A second dialog box is displayed to confirm if the user wants to end the fluid replacement
process.
Figure 5.62 Canceling Fluid Replacement dialog box

5
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If the user did not cancel the fluid replacement process, they can click the Complete button to
finish the fluid replacement process and exit the Coupling Fluid Replacement dialog box.

5-59

5

Software Reference
Run Status Window

5-60

C68411AA

Glossary
There are many terms used throughout this guide that refer to parts of the Echo Array Maker
application. It is useful to know and understand these terms before using the application.
Across — Indicates the ordering of transfers to occur in a row-wise manner.
Array — Specifies a region on a destination microplate or microarray that contains a pattern of
spots. There can be one or more arrays in a Destination array.
Crystallography plate — A 96-well microplate typically containing subdivisions within each
well (shelves).
Dest array or region — Indicates the array within a destination plate (or slide holder) that has
been selected for transfer from a source plate.
Destination array — The combination of a Labware definition, one or more arrays, and spotting
patterns into a single object for developing transfer protocols.
Destination plate — Microplate receiving the transfer contents from one or more source plates.
Down — Indicates the ordering of transfers to occur in a column-wise manner.
Echo qualified microplates — Microplates manufactured for Beckman Coulter and calibrated
for using Echo Liquid Handlers.
Interleave pattern — A pattern consisting of source or destination wells separated by one or
more wells in a column-wise or row-wise direction.
Microarray — Supporting material (as a glass or plastic slide) onto which numerous molecules or
fragments usually of DNA or protein are attached in a regular pattern for use in biochemical or
genetic analysis.
Microplate — A multi-well plate (96, 384, 1536, 3456 wells per plate) complying with the SLAS
standard footprint.
Patterns — Custom arrangement of spots that can be named, saved, and mapped onto a substrate
to create a destination array.
Plate Format — Defines the physical plate based on the number of wells, plate material (for example, PP, PS), and fluid capacity (for example, LDV).
Plate Type — Defines a combination of a physical plate and a fluid type. For example,
384PP_DMSO2 designates a DMSO transfer from a 384 polypropylene plate.
Pre-Transfer Delay — Sets the time delay before starting the transfer line. It is used in cases
where there may be a requirement to incubate shortly between transfers.
Quadrant — One quarter of the total wells available in a microplate.
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Pre-Transfer Delay — Mapping of transfers from source wells to destination wells according to
pre-defined mapping modes. The pre-defined modes include full plate replication, compression,
and decompression.
Quadrant — One quarter of the total wells available in a microplate.
Slide holder — A physical device that holds one or more microarray slides in position during a
sample transfer.
Source plate — Echo qualified microplate containing samples or reagents for transfer to another
microplate serving as a destination plate.
Source Plate Regions — Sub-groups of wells within a source plate that have been selected for
transfer to a destination array.
Spot — A graphical representation of a specific location within a pattern to which a fluid transfer
will be mapped to.
Well — A single division of a microplate designed to contain fluid. The central location of a well
is typically determined by the X and Y offset from the upper-left corner of the microplate (A1).
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Beckman Coulter, Inc.
Customer End User License Agreement
This Product contains software that is owned by Beckman Coulter, Inc. or its suppliers and is protected by
United States and international copyright laws and international trade provisions. You must treat the
software contained in this Product like any other copyrighted material. This license and your right to use the
Product terminate automatically if you violate any part of this agreement.
This is a license agreement and not an agreement for sale. Beckman Coulter hereby licenses this Software to
you under the following terms and conditions:
You May:
1. Use this software in the computer supplied to you by Beckman Coulter;
2. Maintain one copy of this software for backup purposes (the backup copy shall be supplied by Beckman
Coulter);
3. After written notification to Beckman Coulter, transfer the entire Product to another person or entity,
provided you retain no copies of the Product software and the transferee agrees to the terms of this
license agreement.
You May Not:
1. Use, copy or transfer copies of this Software except as provided in this license agreement;
2. Alter, merge, modify or adapt this Software in any way including disassembling or decompiling;
3. Loan, rent, lease, or sublicense this Software or any copy.
Limited Warranty
Beckman Coulter warrants that the software will substantially conform to the published specifications for the
Product in which it is contained, provided that it is used on the computer hardware and in the operating
system environment for which it was designed. Should the media on which your software arrives prove
defective, Beckman Coulter will replace said media free of charge within 90 days of delivery of the Product.
This is your sole remedy for any breech of warranty for this software.
Except as specifically noted above, Beckman Coulter makes no warranty or representation, either expressed
or implied, with respect to this software or its documentation including quality, performance,
merchantability, or fitness for a particular purpose.
No Liability for Consequential Damages
In no event shall Beckman Coulter or its suppliers be liable for any damages whatsoever (including, without
limitation, damages for loss of profits, business interruption, loss of information, or other pecuniary loss)
arising out of the use of or inability to use the Beckman Coulter Product software. Because some states do not
allow the exclusion or limitation of liability for consequential damages, the above limitation might not apply
to you.
General
This agreement constitutes the entire agreement between you and Beckman Coulter and supersedes any
prior agreement concerning this Product software. It shall not be modified except by written agreement
dated subsequent to the date of this agreement signed by an authorized Beckman Coulter representative.
Beckman Coulter is not bound by any provision of any purchase order, receipt, acceptance, confirmation,
correspondence, or otherwise, unless Beckman Coulter specifically agrees to the provision in writing. This
agreement is governed by the laws of the State of California.
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Related Documents
Beckman Coulter documentation consists of the
following publications:
•

Echo Array Maker Quick Start Guide

• Echo Combination Screen User Guide
• Echo Combination Screen Quick Start Guide
• Echo Cherry Pick User Guide
• Echo Cherry Pick Quick Start Guide
• Echo Plate Reformat User Guide
• Echo Plate Reformat Quick Start Guide
• Echo Plate Audit User Guide
• Echo Plate Audit Quick Start Guide
• Echo Dose-Response User Guide
• Echo Dose-Response Quick Start Guide
• Echo 21CFR11 Compliance Manager User Guide
• Echo 21CFR11 Compliance Manager Quick Start Guide
• Echo 21CFR11 Compliance Manager Admin User Guide
• Echo 21CFR11 Compliance Manager Admin Quick Start Guide
• Echo 500 Series Liquid Handler User Guide
• Echo 525 Series Liquid Handler User Guide
• Echo 650 Series Liquid Handler User Guide
• Echo Software Applications Integration Guide
• Echo Liquid Handler Software Integration Guide
• Tempo Automation Control Software User Guide
•

Access Dual Robot System User Guide

www.beckman.com

© 2020 Beckman Coulter, Inc.
All Rights Reserved

